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Calculating 1900 MHz Center Frequencies
Table D-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� TX = 1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05 * 262 = 1943.10 MHz

� RX = TX - 80
Example: Channel 262
RX = 1943.10 - 50 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1931.25 1851.25
50 0032 1932.50 1852.50
75 004B 1933.75 1853.75
100 0064 1935.00 1855.00
125 007D 1936.25 1856.25
150 0096 1937.50 1857.50
175 00AF 1938.75 1858.75
200 00C8 1940.00 1860.00
225 00E1 1941.25 1861.25
250 00FA 1942.50 1862.50
275 0113 1943.75 1863.75
300 012C 1945.00 1865.00
325 0145 1946.25 1866.25
350 015E 1947.50 1867.50
375 0177 1948.75 1868.75
400 0190 1950.00 1870.00
425 01A9 1951.25 1871.25
450 01C2 1952.50 1872.50
475 01DB 1953.75 1873.75
500 01F4 1955.00 1875.00
525 020D 1956.25 1876.25
550 0226 1957.50 1877.50
575 023F 1958.75 1878.75
600 0258 1960.00 1880.00
625 0271 1961.25 1881.25
650 028A 1962.50 1882.50

. . . continued on next page
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Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

675 02A3 1963.75 1883.75
700 02BC 1965.00 1885.00
725 02D5 1966.25 1886.25
750 02EE 1967.50 1887.50
775 0307 1968.75 1888.75
800 0320 1970.00 1890.00
825 0339 1971.25 1891.25
850 0352 1972.50 1892.50
875 036B 1973.75 1893.75
900 0384 1975.00 1895.00
925 039D 1976.25 1896.25
950 03B6 1977.50 1897.50
975 03CF 1978.75 1898.75

1000 03E8 1980.00 1900.00
1025 0401 1981.25 1901.25
1050 041A 1982.50 1902.50
1075 0433 1983.75 1903.75
1100 044C 1985.00 1905.00
1125 0465 1986.25 1906.25
1150 047E 1987.50 1807.50
1175 0497 1988.75 1908.75

 

D



CDMA Operating Frequency Programming Information68P09255A69-3

Aug 2002 1X SC�4812ET Lite BTS Optimization/ATP Software Release 2.16.1.x

PRELIMINARY
D-5

800 MHz CDMA Channels

Figure D-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non-wireline band channels used in a CDMA system (unique per
customer operating system).

Figure D-2: North American Cellular Telephone System Frequency Spectrum (CDMA Allocation).
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Calculating 800 MHz Center Frequencies

Table D-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� Channels 1-777
TX = 870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03*262 = 877.86 MHz

� Channels 1013-1023
TX = 870 + 0.03 * (Channel# - 1023)
Example: Channel 1015
TX = 870 +0.03 *(1015 - 1023) = 869.76 MHz

� RX = TX - 45 MHz
Example: Channel 262
RX = 877.86 -45 = 832.86 MHz

Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

1 0001 870.0300 825.0300

25 0019 870.7500 825.7500

50 0032 871.5000 826.5000
. . . continued on next page
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Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

75 004B 872.2500 827.2500

100 0064 873.0000 828.0000

125 007D 873.7500 828.7500

150 0096 874.5000 829.5000

175 00AF 875.2500 830.2500

200 00C8 876.0000 831.0000

225 00E1 876.7500 831.7500

250 00FA 877.5000 832.5000

275 0113 878.2500 833.2500

300 012C 879.0000 834.0000

325 0145 879.7500 834.7500

350 015E 880.5000 835.5000

375 0177 881.2500 836.2500

400 0190 882.0000 837.0000

425 01A9 882.7500 837.7500

450 01C2 883.5000 838.5000

475 01DB 884.2500 839.2500

500 01F4 885.0000 840.0000

525 020D 885.7500 840.7500

550 0226 886.5000 841.5000

575 023F 887.2500 842.2500

600 0258 888.0000 843.0000

625 0271 888.7500 843.7500

650 028A 889.5000 844.5000

675 02A3 890.2500 845.2500

700 02BC 891.0000 846.0000

725 02D5 891.7500 846.7500

750 02EE 892.5000 847.5000

775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.

1013 03F5 869.7000 824.7000

1023 03FF 870.0000 825.0000
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PN Offset Programming Information

PN Offset Background
All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 64 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Overall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBXs, where the
corresponding I & Q registers reside.

The PN offset values are determined by BTS sector (antenna) based on
the applicale CDF data field content. A breakdown of this information is
found in Table E-1.

PN Offset Usage 
There are three basic RF chip delays currently in use. It is important to
determine what RF chip delay is valid to be able to test the BTS
functionality. This can be done by ascertaining if the CDF FineTxAdj
value was set to “on” when the MCC was downloaded with “image
data”. The FineTxAdj value is used to compensate for the processing
delay (approximately 20 �S) in the BTS using any type of mobile
meeting IS-97 specifications.

Observe the following guidelines:

� If the FineTxAdj value in the CDF is 101 (65 HEX), the FineTxAdj
has not been set. The I and Q values from the 0 table MUST be used.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 14 chip table.

� If the FineTxAdj value in the CDF file is 197 (C5 HEX), FineTxAdj
has been set for the 13 chip table.

NOTE CDF file I and Q values can be represented in DECIMAL or
HEX. If using HEX, add 0x before the HEX value. If necessary,
convert HEX values in Table E-1 to decimal before comparing
them to cdf file I & Q value assignments.

- If a Qualcomm mobile is used, select I and Q values from the 13
chip delay table.

- If a mobile is used that does not have the 1 chip offset problem,
(any mobile meeting the IS-97 specification), select from the 14
chip delay table.

NOTE If the wrong I and Q values are used with the wrong FineTxAdj
parameter, system timing problems will occur. This will cause
the energy transmitted to be “smeared” over several Walsh codes
(instead of the single Walsh code that it was assigned to),
causing erratic operation. Evidence of smearing is usually
identified by Walsh channels not at correct levels or present
when not selected in the Code Domain Power Test.
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

0 17523 23459 4473 5BA3 29673 25581 73E9 63ED 4096 4096 1000 1000

1 32292 32589 7E24 7F4D 16146 29082 3F12 719A 9167 1571 23CF 0623
2 4700 17398 125C 43F6 2350 8699 092E 21FB 22417 7484 5791 1D3C

3 14406 26333 3846 66DD 7203 32082 1C23 7D52 966 6319 03C6 18AF
4 14899 4011 3A33 0FAB 19657 18921 4CC9 49E9 14189 2447 376D 098F

5 17025 2256 4281 08D0 28816 1128 7090 0468 29150 24441 71DE 5F79
6 14745 18651 3999 48DB 19740 27217 4D1C 6A51 18245 27351 4745 6AD7

7 2783 1094 0ADF 0446 21695 547 54BF 0223 1716 23613 06B4 5C3D
8 5832 21202 16C8 52D2 2916 10601 0B64 2969 11915 29008 2E8B 7150

9 12407 13841 3077 3611 18923 21812 49EB 5534 20981 5643 51F5 160B
10 31295 31767 7A3F 7C17 27855 28727 6CCF 7037 24694 28085 6076 6DB5

11 7581 18890 1D9D 49CA 24350 9445 5F1E 24E5 11865 18200 2E59 4718
12 18523 30999 485B 7917 30205 29367 75FD 72B7 6385 21138 18F1 5292

13 29920 22420 74E0 5794 14960 11210 3A70 2BCA 27896 21937 6CF8 55B1
14 25184 20168 6260 4EC8 12592 10084 3130 2764 25240 25222 6298 6286

15 26282 12354 66AA 3042 13141 6177 3355 1821 30877 109 789D 006D
16 30623 11187 779F 2BB3 27167 23525 6A1F 5BE5 30618 6028 779A 178C

17 15540 11834 3CB4 2E3A 7770 5917 1E5A 171D 26373 22034 6705 5612
18 23026 10395 59F2 289B 11513 23153 2CF9 5A71 314 15069 013A 3ADD

19 20019 28035 4E33 6D83 30409 30973 76C9 78FD 17518 4671 446E 123F
20 4050 27399 0FD2 6B07 2025 31679 07E9 7BBF 21927 30434 55A7 76E2

21 1557 22087 0615 5647 21210 25887 52DA 651F 2245 11615 08C5 2D5F
22 30262 2077 7636 081D 15131 18994 3B1B 4A32 18105 19838 46B9 4D7E

23 18000 13758 4650 35BE 9000 6879 2328 1ADF 8792 14713 2258 3979
24 20056 11778 4E58 2E02 10028 5889 272C 1701 21440 241 53C0 00F1

25 12143 3543 2F6F 0DD7 18023 18647 4667 48D7 15493 24083 3C85 5E13
26 17437 7184 441D 1C10 29662 3592 73DE 0E08 26677 7621 6835 1DC5

27 17438 2362 441E 093A 8719 1181 220F 049D 11299 19144 2C23 4AC8
28 5102 25840 13EE 64F0 2551 12920 09F7 3278 12081 1047 2F31 0417

29 9302 12177 2456 2F91 4651 23028 122B 59F4 23833 26152 5D19 6628
30 17154 10402 4302 28A2 8577 5201 2181 1451 20281 22402 4F39 5782

31 5198 1917 144E 077D 2599 19842 0A27 4D82 10676 21255 29B4 5307
32 4606 17708 11FE 452C 2303 8854 08FF 2296 16981 30179 4255 75E3

33 24804 10630 60E4 2986 12402 5315 3072 14C3 31964 7408 7CDC 1CF0
34 17180 6812 431C 1A9C 8590 3406 218E 0D4E 26913 115 6921 0073

35 10507 14350 290B 380E 17749 7175 4555 1C07 14080 1591 3700 0637
36 10157 10999 27AD 2AF7 16902 23367 4206 5B47 23842 1006 5D22 03EE

37 23850 25003 5D2A 61AB 11925 32489 2E95 7EE9 27197 32263 6A3D 7E07
38 31425 2652 7AC1 0A5C 27824 1326 6CB0 052E 22933 1332 5995 0534

39 4075 19898 0FEB 4DBA 22053 9949 5625 26DD 30220 12636 760C 315C
40 10030 2010 272E 07DA 5015 1005 1397 03ED 12443 4099 309B 1003

41 16984 25936 4258 6550 8492 12968 212C 32A8 19854 386 4D8E 0182
42 14225 28531 3791 6F73 18968 31109 4A18 7985 14842 29231 39FA 722F

43 26519 11952 6797 2EB0 25115 5976 621B 1758 15006 25711 3A9E 646F
44 27775 31947 6C7F 7CCB 26607 28761 67EF 7059 702 10913 02BE 2AA1

45 30100 25589 7594 63F5 15050 32710 3ACA 7FC6 21373 8132 537D 1FC4
46 7922 11345 1EF2 2C51 3961 22548 0F79 5814 23874 20844 5D42 516C

47 14199 28198 3777 6E26 19051 14099 4A6B 3713 3468 13150 0D8C 335E
48 17637 13947 44E5 367B 29602 21761 73A2 5501 31323 18184 7A5B 4708

49 23081 8462 5A29 210E 31940 4231 7CC4 1087 29266 19066 7252 4A7A
50 5099 9595 13EB 257B 22565 23681 5825 5C81 16554 29963 40AA 750B

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

51 32743 4670 7FE7 123E 28195 2335 6E23 091F 22575 6605 582F 19CD

52 7114 14672 1BCA 3950 3557 7336 0DE5 1CA8 31456 29417 7AE0 72E9
53 7699 29415 1E13 72E7 24281 30543 5ED9 774F 8148 22993 1FD4 59D1

54 19339 20610 4B8B 5082 29717 10305 7415 2841 19043 27657 4A63 6C09
55 28212 6479 6E34 194F 14106 17051 371A 429B 25438 5468 635E 155C

56 29587 10957 7393 2ACD 26649 23386 6819 5B5A 10938 8821 2ABA 2275
57 19715 18426 4D03 47FA 30545 9213 7751 23FD 2311 20773 0907 5125

58 14901 22726 3A35 58C6 19658 11363 4CCA 2C63 7392 4920 1CE0 1338
59 20160 5247 4EC0 147F 10080 17411 2760 4403 30714 5756 77FA 167C

60 22249 29953 56E9 7501 31396 29884 7AA4 74BC 180 28088 00B4 6DB8
61 26582 5796 67D6 16A4 13291 2898 33EB 0B52 8948 740 22F4 02E4

62 7153 16829 1BF1 41BD 23592 28386 5C28 6EE2 16432 23397 4030 5B65
63 15127 4528 3B17 11B0 19547 2264 4C5B 08D8 9622 19492 2596 4C24

64 15274 5415 3BAA 1527 7637 17583 1DD5 44AF 7524 26451 1D64 6753
65 23149 10294 5A6D 2836 31974 5147 7CE6 141B 1443 30666 05A3 77CA

66 16340 17046 3FD4 4296 8170 8523 1FEA 214B 1810 15088 0712 3AF0
67 27052 7846 69AC 1EA6 13526 3923 34D6 0F53 6941 26131 1B1D 6613

68 13519 10762 34CF 2A0A 19383 5381 4BB7 1505 3238 15969 0CA6 3E61
69 10620 13814 297C 35F6 5310 6907 14BE 1AFB 8141 24101 1FCD 5E25

70 15978 16854 3E6A 41D6 7989 8427 1F35 20EB 10408 12762 28A8 31DA
71 27966 795 6D3E 031B 13983 20401 369F 4FB1 18826 19997 498A 4E1D

72 12479 9774 30BF 262E 18831 4887 498F 1317 22705 22971 58B1 59BB
73 1536 24291 0600 5EE3 768 24909 0300 614D 3879 12560 0F27 3110

74 3199 3172 0C7F 0C64 22511 1586 57EF 0632 21359 31213 536F 79ED
75 4549 2229 11C5 08B5 22834 19046 5932 4A66 30853 18780 7885 495C

76 17888 21283 45E0 5323 8944 26541 22F0 67AD 18078 16353 469E 3FE1
77 13117 16905 333D 4209 18510 28472 484E 6F38 15910 12055 3E26 2F17

78 7506 7062 1D52 1B96 3753 3531 0EA9 0DCB 20989 30396 51FD 76BC
79 27626 7532 6BEA 1D6C 13813 3766 35F5 0EB6 28810 24388 708A 5F44

80 31109 25575 7985 63E7 27922 32719 6D12 7FCF 30759 1555 7827 0613
81 29755 14244 743B 37A4 27597 7122 6BCD 1BD2 18899 13316 49D3 3404

82 26711 28053 6857 6D95 26107 30966 65FB 78F6 7739 31073 1E3B 7961
83 20397 30408 4FAD 76C8 30214 15204 7606 3B64 6279 6187 1887 182B

84 18608 5094 48B0 13E6 9304 2547 2458 09F3 9968 21644 26F0 548C
85 7391 16222 1CDF 3F5E 24511 8111 5FBF 1FAF 8571 9289 217B 2449

86 23168 7159 5A80 1BF7 11584 17351 2D40 43C7 4143 4624 102F 1210
87 23466 174 5BAA 00AE 11733 87 2DD5 0057 19637 467 4CB5 01D3

88 15932 25530 3E3C 63BA 7966 12765 1F1E 31DD 11867 18133 2E5B 46D5
89 25798 2320 64C6 0910 12899 1160 3263 0488 7374 1532 1CCE 05FC

90 28134 23113 6DE6 5A49 14067 25368 36F3 6318 10423 1457 28B7 05B1
91 28024 23985 6D78 5DB1 14012 24804 36BC 60E4 9984 9197 2700 23ED

92 6335 2604 18BF 0A2C 23951 1302 5D8F 0516 7445 13451 1D15 348B
93 21508 1826 5404 0722 10754 913 2A02 0391 4133 25785 1025 64B9

94 26338 30853 66E2 7885 13169 29310 3371 727E 22646 4087 5876 0FF7
95 17186 15699 4322 3D53 8593 20629 2191 5095 15466 31190 3C6A 79D6

96 22462 2589 57BE 0A1D 11231 19250 2BDF 4B32 2164 8383 0874 20BF
97 3908 25000 0F44 61A8 1954 12500 07A2 30D4 16380 12995 3FFC 32C3

98 25390 18163 632E 46F3 12695 27973 3197 6D45 15008 27438 3AA0 6B2E
99 27891 12555 6CF3 310B 26537 22201 67A9 56B9 31755 9297 7C0B 2451

100 9620 8670 2594 21DE 4810 4335 12CA 10EF 31636 1676 7B94 068C

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

101 6491 1290 195B 050A 23933 645 5D7D 0285 25414 12596 6346 3134

102 16876 4407 41EC 1137 8438 18087 20F6 46A7 7102 19975 1BBE 4E07
103 17034 1163 428A 048B 8517 19577 2145 4C79 20516 20026 5024 4E3A

104 32405 12215 7E95 2FB7 28314 23015 6E9A 59E7 19495 8958 4C27 22FE
105 27417 7253 6B19 1C55 25692 16406 645C 4016 17182 19143 431E 4AC7

106 8382 8978 20BE 2312 4191 4489 105F 1189 11572 17142 2D34 42F6
107 5624 25547 15F8 63CB 2812 32729 0AFC 7FD9 25570 19670 63E2 4CD6

108 1424 3130 0590 0C3A 712 1565 02C8 061D 6322 30191 18B2 75EF
109 13034 31406 32EA 7AAE 6517 15703 1975 3D57 8009 5822 1F49 16BE

110 15682 6222 3D42 184E 7841 3111 1EA1 0C27 26708 22076 6854 563C
111 27101 20340 69DD 4F74 25918 10170 653E 27BA 6237 606 185D 025E

112 8521 25094 2149 6206 16756 12547 4174 3103 32520 9741 7F08 260D
113 30232 23380 7618 5B54 15116 11690 3B0C 2DAA 31627 9116 7B8B 239C

114 6429 10926 191D 2AAE 23902 5463 5D5E 1557 3532 12705 0DCC 31A1
115 27116 22821 69EC 5925 13558 25262 34F6 62AE 24090 17502 5E1A 445E

116 4238 31634 108E 7B92 2119 15817 0847 3DC9 20262 18952 4F26 4A08
117 5128 4403 1408 1133 2564 18085 0A04 46A5 18238 15502 473E 3C8E

118 14846 689 39FE 02B1 7423 20324 1CFF 4F64 2033 17819 07F1 459B
119 13024 27045 32E0 69A5 6512 31470 1970 7AEE 25566 4370 63DE 1112

120 10625 27557 2981 6BA5 17680 31726 4510 7BEE 25144 31955 6238 7CD3
121 31724 16307 7BEC 3FB3 15862 20965 3DF6 51E5 29679 30569 73EF 7769

122 13811 22338 35F3 5742 19241 11169 4B29 2BA1 5064 7350 13C8 1CB6
123 24915 27550 6153 6B9E 24953 13775 6179 35CF 27623 26356 6BE7 66F4

124 1213 22096 04BD 5650 21390 11048 538E 2B28 13000 32189 32C8 7DBD
125 2290 23136 08F2 5A60 1145 11568 0479 2D30 31373 1601 7A8D 0641

126 31551 12199 7B3F 2FA7 27727 23023 6C4F 59EF 13096 19537 3328 4C51
127 12088 1213 2F38 04BD 6044 19554 179C 4C62 26395 25667 671B 6443

128 7722 936 1E2A 03A8 3861 468 0F15 01D4 15487 4415 3C7F 113F
129 27312 6272 6AB0 1880 13656 3136 3558 0C40 29245 2303 723D 08FF

130 23130 32446 5A5A 7EBE 11565 16223 2D2D 3F5F 26729 16362 6869 3FEA
131 594 13555 0252 34F3 297 21573 0129 5445 12568 28620 3118 6FCC

132 25804 8789 64CC 2255 12902 24342 3266 5F16 24665 6736 6059 1A50
133 31013 24821 7925 60F5 27970 32326 6D42 7E46 8923 2777 22DB 0AD9

134 32585 21068 7F49 524C 28276 10534 6E74 2926 19634 24331 4CB2 5F0B
135 3077 31891 0C05 7C93 22482 28789 57D2 7075 29141 9042 71D5 2352

136 17231 5321 434F 14C9 28791 17496 7077 4458 73 107 0049 006B
137 31554 551 7B42 0227 15777 20271 3DA1 4F2F 26482 4779 6772 12AB

138 8764 12115 223C 2F53 4382 22933 111E 5995 6397 13065 18FD 3309
139 15375 4902 3C0F 1326 20439 2451 4FD7 0993 29818 30421 747A 76D5

140 13428 1991 3474 07C7 6714 19935 1A3A 4DDF 8153 20210 1FD9 4EF2
141 17658 14404 44FA 3844 8829 7202 227D 1C22 302 5651 012E 1613

142 13475 17982 34A3 463E 19329 8991 4B81 231F 28136 31017 6DE8 7929
143 22095 19566 564F 4C6E 31479 9783 7AF7 2637 29125 30719 71C5 77FF

144 24805 2970 60E5 0B9A 24994 1485 61A2 05CD 8625 23104 21B1 5A40
145 4307 23055 10D3 5A0F 22969 25403 59B9 633B 26671 7799 682F 1E77

146 23292 15158 5AFC 3B36 11646 7579 2D7E 1D9B 6424 17865 1918 45C9
147 1377 29094 0561 71A6 21344 14547 5360 38D3 12893 26951 325D 6947

148 28654 653 6FEE 028D 14327 20346 37F7 4F7A 18502 25073 4846 61F1
149 6350 19155 18CE 4AD3 3175 27477 0C67 6B55 7765 32381 1E55 7E7D

150 16770 23588 4182 5C24 8385 11794 20C1 2E12 25483 16581 638B 40C5
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

151 14726 10878 3986 2A7E 7363 5439 1CC3 153F 15408 32087 3C30 7D57

152 25685 31060 6455 7954 25594 15530 63FA 3CAA 6414 97 190E 0061
153 21356 30875 536C 789B 10678 29297 29B6 7271 8164 7618 1FE4 1DC2

154 12149 11496 2F75 2CE8 18026 5748 466A 1674 10347 93 286B 005D
155 28966 24545 7126 5FE1 14483 25036 3893 61CC 29369 16052 72B9 3EB4

156 22898 9586 5972 2572 11449 4793 2CB9 12B9 10389 14300 2895 37DC
157 1713 20984 06B1 51F8 21128 10492 5288 28FC 24783 11129 60CF 2B79

158 30010 30389 753A 76B5 15005 30054 3A9D 7566 18400 6602 47E0 19CA
159 2365 7298 093D 1C82 21838 3649 554E 0E41 22135 14460 5677 387C

160 27179 18934 6A2B 49F6 25797 9467 64C5 24FB 4625 25458 1211 6372
161 29740 23137 742C 5A61 14870 25356 3A16 630C 22346 15869 574A 3DFD

162 5665 24597 1621 6015 23232 32310 5AC0 7E36 2545 27047 09F1 69A7
163 23671 23301 5C77 5B05 32747 25534 7FEB 63BE 7786 26808 1E6A 68B8

164 1680 7764 0690 1E54 840 3882 0348 0F2A 20209 7354 4EF1 1CBA
165 25861 14518 6505 38B6 25426 7259 6352 1C5B 26414 27834 672E 6CBA

166 25712 21634 6470 5482 12856 10817 3238 2A41 1478 11250 05C6 2BF2
167 19245 11546 4B2D 2D1A 29766 5773 7446 168D 15122 552 3B12 0228

168 26887 26454 6907 6756 25939 13227 6553 33AB 24603 27058 601B 69B2
169 30897 15938 78B1 3E42 28040 7969 6D88 1F21 677 14808 02A5 39D8

170 11496 9050 2CE8 235A 5748 4525 1674 11AD 13705 9642 3589 25AA
171 1278 3103 04FE 0C1F 639 18483 027F 4833 13273 32253 33D9 7DFD

172 31555 758 7B43 02F6 27761 379 6C71 017B 14879 26081 3A1F 65E1
173 29171 16528 71F3 4090 26921 8264 6929 2048 6643 21184 19F3 52C0

174 20472 20375 4FF8 4F97 10236 27127 27FC 69F7 23138 11748 5A62 2DE4
175 5816 10208 16B8 27E0 2908 5104 0B5C 13F0 28838 32676 70A6 7FA4

176 30270 17698 763E 4522 15135 8849 3B1F 2291 9045 2425 2355 0979
177 22188 8405 56AC 20D5 11094 24150 2B56 5E56 10792 19455 2A28 4BFF

178 6182 28634 1826 6FDA 3091 14317 0C13 37ED 25666 19889 6442 4DB1
179 32333 1951 7E4D 079F 28406 19955 6EF6 4DF3 11546 18177 2D1A 4701

180 14046 20344 36DE 4F78 7023 10172 1B6F 27BC 15535 2492 3CAF 09BC
181 15873 26696 3E01 6848 20176 13348 4ED0 3424 16134 15086 3F06 3AEE

182 19843 3355 4D83 0D1B 30481 18609 7711 48B1 8360 30632 20A8 77A8
183 29367 11975 72B7 2EC7 26763 22879 688B 595F 14401 27549 3841 6B9D

184 13352 31942 3428 7CC6 6676 15971 1A14 3E63 26045 6911 65BD 1AFF
185 22977 9737 59C1 2609 32048 23864 7D30 5D38 24070 9937 5E06 26D1

186 31691 9638 7BCB 25A6 27701 4819 6C35 12D3 30300 2467 765C 09A3
187 10637 30643 298D 77B3 17686 30181 4516 75E5 13602 25831 3522 64E7

188 25454 13230 636E 33AE 12727 6615 31B7 19D7 32679 32236 7FA7 7DEC
189 18610 22185 48B2 56A9 9305 25960 2459 6568 16267 12987 3F8B 32BB

190 6368 2055 18E0 0807 3184 19007 0C70 4A3F 9063 11714 2367 2DC2
191 7887 8767 1ECF 223F 24247 24355 5EB7 5F23 19487 19283 4C1F 4B53

192 7730 15852 1E32 3DEC 3865 7926 0F19 1EF6 12778 11542 31EA 2D16
193 23476 16125 5BB4 3EFD 11738 20802 2DDA 5142 27309 27928 6AAD 6D18

194 889 6074 0379 17BA 20588 3037 506C 0BDD 12527 26637 30EF 680D
195 21141 31245 5295 7A0D 30874 29498 789A 733A 953 10035 03B9 2733

196 20520 15880 5028 3E08 10260 7940 2814 1F04 15958 10748 3E56 29FC
197 21669 20371 54A5 4F93 31618 27125 7B82 69F5 6068 24429 17B4 5F6D

198 15967 8666 3E5F 21DA 20223 4333 4EFF 10ED 23577 29701 5C19 7405
199 21639 816 5487 0330 31635 408 7B93 0198 32156 14997 7D9C 3A95

200 31120 22309 7990 5725 15560 26030 3CC8 65AE 32709 32235 7FC5 7DEB
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14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

201 3698 29563 0E72 737B 1849 30593 0739 7781 23557 30766 5C05 782E

202 16322 13078 3FC2 3316 8161 6539 1FE1 198B 17638 5985 44E6 1761
203 17429 10460 4415 28DC 29658 5230 73DA 146E 3545 6823 0DD9 1AA7

204 21730 17590 54E2 44B6 10865 8795 2A71 225B 9299 20973 2453 51ED
205 17808 20277 4590 4F35 8904 27046 22C8 69A6 6323 10197 18B3 27D5

206 30068 19988 7574 4E14 15034 9994 3ABA 270A 19590 9618 4C86 2592
207 12737 6781 31C1 1A7D 18736 17154 4930 4302 7075 22705 1BA3 58B1

208 28241 32501 6E51 7EF5 26360 28998 66F8 7146 14993 5234 3A91 1472
209 20371 6024 4F93 1788 30233 3012 7619 0BC4 19916 12541 4DCC 30FD

210 13829 20520 3605 5028 19154 10260 4AD2 2814 6532 8019 1984 1F53
211 13366 31951 3436 7CCF 6683 28763 1A1B 705B 17317 22568 43A5 5828

212 25732 26063 6484 65CF 12866 31963 3242 7CDB 16562 5221 40B2 1465
213 19864 27203 4D98 6A43 9932 31517 26CC 7B1D 26923 25216 692B 6280

214 5187 6614 1443 19D6 23537 3307 5BF1 0CEB 9155 1354 23C3 054A
215 23219 10970 5AB3 2ADA 31881 5485 7C89 156D 20243 29335 4F13 7297

216 28242 5511 6E52 1587 14121 17663 3729 44FF 32391 6682 7E87 1A1A
217 6243 17119 1863 42DF 24033 28499 5DE1 6F53 20190 26128 4EDE 6610

218 445 16064 01BD 3EC0 20750 8032 510E 1F60 27564 29390 6BAC 72CE
219 21346 31614 5362 7B7E 10673 15807 29B1 3DBF 20869 8852 5185 2294

220 13256 4660 33C8 1234 6628 2330 19E4 091A 9791 6110 263F 17DE
221 18472 13881 4828 3639 9236 21792 2414 5520 714 11847 02CA 2E47

222 25945 16819 6559 41B3 25468 28389 637C 6EE5 7498 10239 1D4A 27FF
223 31051 6371 794B 18E3 28021 16973 6D75 424D 23278 6955 5AEE 1B2B

224 1093 24673 0445 6061 21490 32268 53F2 7E0C 8358 10897 20A6 2A91
225 5829 6055 16C5 17A7 23218 17903 5AB2 45EF 9468 14076 24FC 36FC

226 31546 10009 7B3A 2719 15773 23984 3D9D 5DB0 23731 12450 5CB3 30A2
227 29833 5957 7489 1745 27540 17822 6B94 459E 25133 8954 622D 22FA

228 18146 11597 46E2 2D4D 9073 22682 2371 589A 2470 19709 09A6 4CFD
229 24813 22155 60ED 568B 24998 25977 61A6 6579 17501 1252 445D 04E4

230 47 15050 002F 3ACA 20935 7525 51C7 1D65 24671 15142 605F 3B26
231 3202 16450 0C82 4042 1601 8225 0641 2021 11930 26958 2E9A 694E

232 21571 27899 5443 6CFB 31729 30785 7BF1 7841 9154 8759 23C2 2237
233 7469 2016 1D2D 07E0 24390 1008 5F46 03F0 7388 12696 1CDC 3198

234 25297 17153 62D1 4301 24760 28604 60B8 6FBC 3440 11936 0D70 2EA0
235 8175 15849 1FEF 3DE9 24103 20680 5E27 50C8 27666 25635 6C12 6423

236 28519 30581 6F67 7775 26211 30086 6663 7586 22888 17231 5968 434F
237 4991 3600 137F 0E10 22639 1800 586F 0708 13194 22298 338A 571A

238 7907 4097 1EE3 1001 24225 17980 5EA1 463C 26710 7330 6856 1CA2
239 17728 671 4540 029F 8864 20339 22A0 4F73 7266 30758 1C62 7826

240 14415 20774 384F 5126 19959 10387 4DF7 2893 15175 6933 3B47 1B15
241 30976 24471 7900 5F97 15488 25079 3C80 61F7 15891 2810 3E13 0AFA

242 26376 27341 6708 6ACD 13188 31578 3384 7B5A 26692 8820 6844 2274
243 19063 19388 4A77 4BBC 29931 9694 74EB 25DE 14757 7831 39A5 1E97

244 19160 25278 4AD8 62BE 9580 12639 256C 315F 28757 19584 7055 4C80
245 3800 9505 0ED8 2521 1900 23724 076C 5CAC 31342 2944 7A6E 0B80

246 8307 26143 2073 661F 16873 32051 41E9 7D33 19435 19854 4BEB 4D8E
247 12918 13359 3276 342F 6459 21547 193B 542B 2437 10456 0985 28D8

248 19642 2154 4CBA 086A 9821 1077 265D 0435 20573 17036 505D 428C
249 24873 13747 6129 35B3 24900 21733 6144 54E5 18781 2343 495D 0927

250 22071 27646 5637 6BFE 31435 13823 7ACB 35FF 18948 14820 4A04 39E4
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14-Chip Delay 13-Chip Delay 0-Chip Delay
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251 13904 1056 3650 0420 6952 528 1B28 0210 23393 1756 5B61 06DC

252 27198 1413 6A3E 0585 13599 19710 351F 4CFE 5619 19068 15F3 4A7C
253 3685 3311 0E65 0CEF 22242 18507 56E2 484B 17052 28716 429C 702C

254 16820 4951 41B4 1357 8410 18327 20DA 4797 21292 31958 532C 7CD6
255 22479 749 57CF 02ED 31287 20298 7A37 4F4A 2868 16097 0B34 3EE1

256 6850 6307 1AC2 18A3 3425 17005 0D61 426D 19538 1308 4C52 051C
257 15434 961 3C4A 03C1 7717 20444 1E25 4FDC 24294 3320 5EE6 0CF8

258 19332 2358 4B84 0936 9666 1179 25C2 049B 22895 16682 596F 412A
259 8518 28350 2146 6EBE 4259 14175 10A3 375F 27652 6388 6C04 18F4

260 14698 31198 396A 79DE 7349 15599 1CB5 3CEF 29905 12828 74D1 321C
261 21476 11467 53E4 2CCB 10738 22617 29F2 5859 21415 3518 53A7 0DBE

262 30475 8862 770B 229E 27221 4431 6A55 114F 1210 3494 04BA 0DA6
263 23984 6327 5DB0 18B7 11992 16999 2ED8 4267 22396 6458 577C 193A

264 1912 7443 0778 1D13 956 16565 03BC 40B5 26552 10717 67B8 29DD
265 26735 28574 686F 6F9E 26087 14287 65E7 37CF 24829 8463 60FD 210F

266 15705 25093 3D59 6205 20348 32574 4F7C 7F3E 8663 27337 21D7 6AC9
267 3881 6139 0F29 17FB 22084 17857 5644 45C1 991 19846 03DF 4D86

268 20434 22047 4FD2 561F 10217 25907 27E9 6533 21926 9388 55A6 24AC
269 16779 32545 418B 7F21 28949 29100 7115 71AC 23306 21201 5B0A 52D1

270 31413 7112 7AB5 1BC8 27786 3556 6C8A 0DE4 13646 31422 354E 7ABE
271 16860 28535 41DC 6F77 8430 31111 20EE 7987 148 166 0094 00A6

272 8322 10378 2082 288A 4161 5189 1041 1445 24836 28622 6104 6FCE
273 28530 15065 6F72 3AD9 14265 21328 37B9 5350 24202 6477 5E8A 194D

274 26934 5125 6936 1405 13467 17470 349B 443E 9820 10704 265C 29D0
275 18806 12528 4976 30F0 9403 6264 24BB 1878 12939 25843 328B 64F3

276 20216 23215 4EF8 5AAF 10108 25451 277C 636B 2364 25406 093C 633E
277 9245 20959 241D 51DF 17374 26323 43DE 66D3 14820 21523 39E4 5413

278 8271 3568 204F 0DF0 16887 1784 41F7 06F8 2011 8569 07DB 2179
279 18684 26453 48FC 6755 9342 32150 247E 7D96 13549 9590 34ED 2576

280 8220 29421 201C 72ED 4110 30538 100E 774A 28339 22466 6EB3 57C2
281 6837 24555 1AB5 5FEB 23690 25033 5C8A 61C9 25759 12455 649F 30A7

282 9613 10779 258D 2A1B 17174 23345 4316 5B31 11116 27506 2B6C 6B72
283 31632 25260 7B90 62AC 15816 12630 3DC8 3156 31448 21847 7AD8 5557

284 27448 16084 6B38 3ED4 13724 8042 359C 1F6A 27936 28392 6D20 6EE8
285 12417 26028 3081 65AC 18832 13014 4990 32D6 3578 1969 0DFA 07B1

286 30901 29852 78B5 749C 28042 14926 6D8A 3A4E 12371 30715 3053 77FB
287 9366 14978 2496 3A82 4683 7489 124B 1D41 12721 23674 31B1 5C7A

288 12225 12182 2FC1 2F96 17968 6091 4630 17CB 10264 22629 2818 5865
289 21458 25143 53D2 6237 10729 32551 29E9 7F27 25344 12857 6300 3239

290 6466 15838 1942 3DDE 3233 7919 0CA1 1EEF 13246 30182 33BE 75E6
291 8999 5336 2327 14D8 16451 2668 4043 0A6C 544 21880 0220 5578

292 26718 21885 685E 557D 13359 25730 342F 6482 9914 6617 26BA 19D9
293 3230 20561 0C9E 5051 1615 26132 064F 6614 4601 27707 11F9 6C3B

294 27961 30097 6D39 7591 26444 29940 674C 74F4 16234 16249 3F6A 3F79
295 28465 21877 6F31 5575 26184 25734 6648 6486 24475 24754 5F9B 60B2

296 6791 23589 1A87 5C25 23699 24622 5C93 602E 26318 31609 66CE 7B79
297 17338 26060 43BA 65CC 8669 13030 21DD 32E6 6224 22689 1850 58A1

298 11832 9964 2E38 26EC 5916 4982 171C 1376 13381 3226 3445 0C9A
299 11407 25959 2C8F 6567 18327 31887 4797 7C8F 30013 4167 753D 1047

300 15553 3294 3CC1 0CDE 20400 1647 4FB0 066F 22195 25624 56B3 6418
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E



PN Offset Programming Information68P09255A69-3

Aug 2002 1X SC�4812ET Lite BTS Optimization/ATP Software Release 2.16.1.x

PRELIMINARY
E-9

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

301 17418 30173 440A 75DD 8709 29906 2205 74D2 30380 10924 76AC 2AAC

302 14952 15515 3A68 3C9B 7476 20593 1D34 5071 15337 23096 3BE9 5A38
303 52 5371 0034 14FB 26 17473 001A 4441 10716 22683 29DC 589B

304 27254 10242 6A76 2802 13627 5121 353B 1401 13592 10955 3518 2ACB
305 15064 28052 3AD8 6D94 7532 14026 1D6C 36CA 2412 17117 096C 42DD

306 10942 14714 2ABE 397A 5471 7357 155F 1CBD 15453 15837 3C5D 3DDD
307 377 19550 0179 4C5E 20844 9775 516C 262F 13810 22647 35F2 5877

308 14303 8866 37DF 22A2 19007 4433 4A3F 1151 12956 10700 329C 29CC
309 24427 15297 5F6B 3BC1 32357 21468 7E65 53DC 30538 30293 774A 7655

310 26629 10898 6805 2A92 26066 5449 65D2 1549 10814 5579 2A3E 15CB
311 20011 31315 4E2B 7A53 30405 29461 76C5 7315 18939 11057 49FB 2B31

312 16086 19475 3ED6 4C13 8043 26677 1F6B 6835 19767 30238 4D37 761E
313 24374 1278 5F36 04FE 12187 639 2F9B 027F 20547 14000 5043 36B0

314 9969 11431 26F1 2CA7 17064 22639 42A8 586F 29720 22860 7418 594C
315 29364 31392 72B4 7AA0 14682 15696 395A 3D50 31831 27172 7C57 6A24

316 25560 4381 63D8 111D 12780 18098 31EC 46B2 26287 307 66AF 0133
317 28281 14898 6E79 3A32 26348 7449 66EC 1D19 11310 20380 2C2E 4F9C

318 7327 23959 1C9F 5D97 24479 24823 5F9F 60F7 25724 26427 647C 673B
319 32449 16091 7EC1 3EDB 28336 20817 6EB0 5151 21423 10702 53AF 29CE

320 26334 9037 66DE 234D 13167 24474 336F 5F9A 5190 30024 1446 7548
321 14760 24162 39A8 5E62 7380 12081 1CD4 2F31 258 14018 0102 36C2

322 15128 6383 3B18 18EF 7564 16971 1D8C 424B 13978 4297 369A 10C9
323 29912 27183 74D8 6A2F 14956 31531 3A6C 7B2B 4670 13938 123E 3672

324 4244 16872 1094 41E8 2122 8436 084A 20F4 23496 25288 5BC8 62C8
325 8499 9072 2133 2370 16713 4536 4149 11B8 23986 27294 5DB2 6A9E

326 9362 12966 2492 32A6 4681 6483 1249 1953 839 31835 0347 7C5B
327 10175 28886 27BF 70D6 16911 14443 420F 386B 11296 8228 2C20 2024

328 30957 25118 78ED 621E 28070 12559 6DA6 310F 30913 12745 78C1 31C9
329 12755 20424 31D3 4FC8 18745 10212 4939 27E4 27297 6746 6AA1 1A5A

330 19350 6729 4B96 1A49 9675 17176 25CB 4318 10349 1456 286D 05B0
331 1153 20983 0481 51F7 21392 26311 5390 66C7 32504 27743 7EF8 6C5F

332 29304 12372 7278 3054 14652 6186 393C 182A 18405 27443 47E5 6B33
333 6041 13948 1799 367C 23068 6974 5A1C 1B3E 3526 31045 0DC6 7945

334 21668 27547 54A4 6B9B 10834 31729 2A52 7BF1 19161 12225 4AD9 2FC1
335 28048 8152 6D90 1FD8 14024 4076 36C8 0FEC 23831 21482 5D17 53EA

336 10096 17354 2770 43CA 5048 8677 13B8 21E5 21380 14678 5384 3956
337 23388 17835 5B5C 45AB 11694 27881 2DAE 6CE9 4282 30656 10BA 77C0

338 15542 14378 3CB6 382A 7771 7189 1E5B 1C15 32382 13721 7E7E 3599
339 24013 7453 5DCD 1D1D 32566 16562 7F36 40B2 806 21831 0326 5547

340 2684 26317 0A7C 66CD 1342 32090 053E 7D5A 6238 30208 185E 7600
341 19018 5955 4A4A 1743 9509 17821 2525 459D 10488 9995 28F8 270B

342 25501 10346 639D 286A 24606 5173 601E 1435 19507 3248 4C33 0CB0
343 4489 13200 1189 3390 22804 6600 5914 19C8 27288 12030 6A98 2EFE

344 31011 30402 7923 76C2 27969 15201 6D41 3B61 2390 5688 0956 1638
345 29448 7311 7308 1C8F 14724 16507 3984 407B 19094 2082 4A96 0822

346 25461 3082 6375 0C0A 24682 1541 606A 0605 13860 23143 3624 5A67
347 11846 21398 2E46 5396 5923 10699 1723 29CB 9225 25906 2409 6532

348 30331 31104 767B 7980 27373 15552 6AED 3CC0 2505 15902 09C9 3E1E
349 10588 24272 295C 5ED0 5294 12136 14AE 2F68 27806 21084 6C9E 525C

350 32154 27123 7D9A 69F3 16077 31429 3ECD 7AC5 2408 25723 0968 647B
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351 29572 5578 7384 15CA 14786 2789 39C2 0AE5 13347 13427 3423 3473

352 13173 25731 3375 6483 18538 31869 486A 7C7D 7885 31084 1ECD 796C
353 10735 10662 29EF 29A6 17703 5331 4527 14D3 6669 24023 1A0D 5DD7

354 224 11084 00E0 2B4C 112 5542 0070 15A6 8187 23931 1FFB 5D7B
355 12083 31098 2F33 797A 17993 15549 4649 3CBD 18145 15836 46E1 3DDC

356 22822 16408 5926 4018 11411 8204 2C93 200C 14109 6085 371D 17C5
357 2934 6362 0B76 18DA 1467 3181 05BB 0C6D 14231 30324 3797 7674

358 27692 2719 6C2C 0A9F 13846 19315 3616 4B73 27606 27561 6BD6 6BA9
359 10205 14732 27DD 398C 16958 7366 423E 1CC6 783 13821 030F 35FD

360 7011 22744 1B63 58D8 23649 11372 5C61 2C6C 6301 269 189D 010D
361 22098 1476 5652 05C4 11049 738 2B29 02E2 5067 28663 13CB 6FF7

362 2640 8445 0A50 20FD 1320 24130 0528 5E42 15383 29619 3C17 73B3
363 4408 21118 1138 527E 2204 10559 089C 293F 1392 2043 0570 07FB

364 102 22198 0066 56B6 51 11099 0033 2B5B 7641 6962 1DD9 1B32
365 27632 22030 6BF0 560E 13816 11015 35F8 2B07 25700 29119 6464 71BF

366 19646 10363 4CBE 287B 9823 23041 265F 5A01 25259 22947 62AB 59A3
367 26967 25802 6957 64CA 25979 12901 657B 3265 19813 9612 4D65 258C

368 32008 2496 7D08 09C0 16004 1248 3E84 04E0 20933 18698 51C5 490A
369 7873 31288 1EC1 7A38 24240 15644 5EB0 3D1C 638 16782 027E 418E

370 655 24248 028F 5EB8 20631 12124 5097 2F5C 16318 29735 3FBE 7427
371 25274 14327 62BA 37F7 12637 21959 315D 55C7 6878 2136 1ADE 0858

372 16210 23154 3F52 5A72 8105 11577 1FA9 2D39 1328 8086 0530 1F96
373 11631 13394 2D6F 3452 18279 6697 4767 1A29 14744 10553 3998 2939

374 8535 1806 2157 070E 16763 903 417B 0387 22800 11900 5910 2E7C
375 19293 17179 4B5D 431B 29822 28593 747E 6FB1 25919 19996 653F 4E1C

376 12110 10856 2F4E 2A68 6055 5428 17A7 1534 4795 5641 12BB 1609
377 21538 25755 5422 649B 10769 31857 2A11 7C71 18683 28328 48FB 6EA8

378 10579 15674 2953 3D3A 17785 7837 4579 1E9D 32658 25617 7F92 6411
379 13032 7083 32E8 1BAB 6516 17385 1974 43E9 1586 26986 0632 696A

380 14717 29096 397D 71A8 19822 14548 4D6E 38D4 27208 5597 6A48 15DD
381 11666 3038 2D92 0BDE 5833 1519 16C9 05EF 17517 14078 446D 36FE

382 25809 16277 64D1 3F95 25528 20982 63B8 51F6 599 13247 0257 33BF
383 5008 25525 1390 63B5 2504 32742 09C8 7FE6 16253 499 3F7D 01F3

384 32418 20465 7EA2 4FF1 16209 27076 3F51 69C4 8685 30469 21ED 7705
385 22175 28855 569F 70B7 31391 30311 7A9F 7667 29972 17544 7514 4488

386 11742 32732 2DDE 7FDC 5871 16366 16EF 3FEE 22128 28510 5670 6F5E
387 22546 20373 5812 4F95 11273 27126 2C09 69F6 19871 23196 4D9F 5A9C

388 21413 9469 53A5 24FD 30722 23618 7802 5C42 19405 13384 4BCD 3448
389 133 26155 0085 662B 20882 32041 5192 7D29 17972 4239 4634 108F

390 4915 6957 1333 1B2D 22601 17322 5849 43AA 8599 20725 2197 50F5
391 8736 12214 2220 2FB6 4368 6107 1110 17DB 10142 6466 279E 1942

392 1397 21479 0575 53E7 21354 26575 536A 67CF 26834 28465 68D2 6F31
393 18024 31914 4668 7CAA 9012 15957 2334 3E55 23710 19981 5C9E 4E0D

394 15532 32311 3CAC 7E37 7766 28967 1E56 7127 27280 16723 6A90 4153
395 26870 11276 68F6 2C0C 13435 5638 347B 1606 6570 4522 19AA 11AA

396 5904 20626 1710 5092 2952 10313 0B88 2849 7400 678 1CE8 02A6
397 24341 423 5F15 01A7 32346 20207 7E5A 4EEF 26374 15320 6706 3BD8

398 13041 2679 32F1 0A77 18600 19207 48A8 4B07 22218 29116 56CA 71BC
399 23478 15537 5BB6 3CB1 11739 20580 2DDB 5064 29654 5388 73D6 150C

400 1862 10818 0746 2A42 931 5409 03A3 1521 13043 22845 32F3 593D

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

401 5850 23074 16DA 5A22 2925 11537 0B6D 2D11 24457 28430 5F89 6F0E

402 5552 20250 15B0 4F1A 2776 10125 0AD8 278D 17161 8660 4309 21D4
403 12589 14629 312D 3925 18758 21166 4946 52AE 21314 2659 5342 0A63

404 23008 29175 59E0 71F7 11504 30407 2CF0 76C7 28728 8803 7038 2263
405 27636 13943 6BF4 3677 13818 21767 35FA 5507 22162 19690 5692 4CEA

406 17600 11072 44C0 2B40 8800 5536 2260 15A0 26259 22169 6693 5699
407 17000 29492 4268 7334 8500 14746 2134 399A 22180 8511 56A4 213F

408 21913 5719 5599 1657 31516 17687 7B1C 4517 2266 17393 08DA 43F1
409 30320 7347 7670 1CB3 15160 16485 3B38 4065 10291 11336 2833 2C48

410 28240 12156 6E50 2F7C 14120 6078 3728 17BE 26620 13576 67FC 3508
411 7260 25623 1C5C 6417 3630 31799 0E2E 7C37 19650 22820 4CC2 5924

412 17906 27725 45F2 6C4D 8953 30746 22F9 781A 14236 13344 379C 3420
413 5882 28870 16FA 70C6 2941 14435 0B7D 3863 11482 20107 2CDA 4E8B

414 22080 31478 5640 7AF6 11040 15739 2B20 3D7B 25289 8013 62C9 1F4D
415 12183 28530 2F97 6F72 17947 14265 461B 37B9 12011 18835 2EEB 4993

416 23082 24834 5A2A 6102 11541 12417 2D15 3081 13892 16793 3644 4199
417 17435 9075 441B 2373 29661 24453 73DD 5F85 17336 9818 43B8 265A

418 18527 32265 485F 7E09 30207 28984 75FF 7138 10759 4673 2A07 1241
419 31902 3175 7C9E 0C67 15951 18447 3E4F 480F 26816 13609 68C0 3529

420 18783 17434 495F 441A 30079 8717 757F 220D 31065 10054 7959 2746
421 20027 12178 4E3B 2F92 30413 6089 76CD 17C9 8578 10988 2182 2AEC

422 7982 25613 1F2E 640D 3991 31802 0F97 7C3A 24023 14744 5DD7 3998
423 20587 31692 506B 7BCC 31205 15846 79E5 3DE6 16199 17930 3F47 460A

424 10004 25384 2714 6328 5002 12692 138A 3194 22310 25452 5726 636C
425 13459 18908 3493 49DC 19353 9454 4B99 24EE 30402 11334 76C2 2C46

426 13383 25816 3447 64D8 19443 12908 4BF3 326C 16613 15451 40E5 3C5B
427 28930 4661 7102 1235 14465 18214 3881 4726 13084 11362 331C 2C62

428 4860 31115 12FC 798B 2430 29433 097E 72F9 3437 2993 0D6D 0BB1
429 13108 7691 3334 1E0B 6554 16697 199A 4139 1703 11012 06A7 2B04

430 24161 1311 5E61 051F 32480 19635 7EE0 4CB3 22659 5806 5883 16AE
431 20067 16471 4E63 4057 30433 28183 76E1 6E17 26896 20180 6910 4ED4

432 2667 15771 0A6B 3D9B 21733 20721 54E5 50F1 1735 8932 06C7 22E4
433 13372 16112 343C 3EF0 6686 8056 1A1E 1F78 16178 23878 3F32 5D46

434 28743 21062 7047 5246 27123 10531 69F3 2923 19166 20760 4ADE 5118
435 24489 29690 5FA9 73FA 32260 14845 7E04 39FD 665 32764 0299 7FFC

436 249 10141 00F9 279D 20908 24050 51AC 5DF2 20227 32325 4F03 7E45
437 19960 19014 4DF8 4A46 9980 9507 26FC 2523 24447 25993 5F7F 6589

438 29682 22141 73F2 567D 14841 25858 39F9 6502 16771 3268 4183 0CC4
439 31101 11852 797D 2E4C 28014 5926 6D6E 1726 27209 25180 6A49 625C

440 27148 26404 6A0C 6724 13574 13202 3506 3392 6050 12149 17A2 2F75
441 26706 30663 6852 77C7 13353 30175 3429 75DF 29088 10193 71A0 27D1

442 5148 32524 141C 7F0C 2574 16262 0A0E 3F86 7601 9128 1DB1 23A8
443 4216 28644 1078 6FE4 2108 14322 083C 37F2 4905 7843 1329 1EA3

444 5762 10228 1682 27F4 2881 5114 0B41 13FA 5915 25474 171B 6382
445 245 23536 00F5 5BF0 20906 11768 51AA 2DF8 6169 11356 1819 2C5C

446 21882 18045 557A 467D 10941 27906 2ABD 6D02 21303 11226 5337 2BDA
447 3763 25441 0EB3 6361 22153 32652 5689 7F8C 28096 16268 6DC0 3F8C

448 206 27066 00CE 69BA 103 13533 0067 34DD 8905 14491 22C9 389B
449 28798 13740 707E 35AC 14399 6870 383F 1AD6 26997 8366 6975 20AE

450 32402 13815 7E92 35F7 16201 21703 3F49 54C7 15047 26009 3AC7 6599

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

451 13463 3684 3497 0E64 19355 1842 4B9B 0732 17460 5164 4434 142C

452 15417 23715 3C39 5CA3 20428 24685 4FCC 606D 17629 17126 44DD 42E6
453 23101 15314 5A3D 3BD2 31950 7657 7CCE 1DE9 10461 21566 28DD 543E

454 14957 32469 3A6D 7ED5 19686 29014 4CE6 7156 21618 21845 5472 5555
455 23429 9816 5B85 2658 31762 4908 7C12 132C 11498 28149 2CEA 6DF5

456 12990 4444 32BE 115C 6495 2222 195F 08AE 193 9400 00C1 24B8
457 12421 5664 3085 1620 18834 2832 4992 0B10 16140 19459 3F0C 4C03

458 28875 7358 70CB 1CBE 27061 3679 69B5 0E5F 13419 7190 346B 1C16
459 4009 27264 0FA9 6A80 22020 13632 5604 3540 10864 3101 2A70 0C1D

460 1872 28128 0750 6DE0 936 14064 03A8 36F0 28935 491 7107 01EB
461 15203 30168 3B63 75D8 19553 15084 4C61 3AEC 18765 25497 494D 6399

462 30109 29971 759D 7513 27422 29877 6B1E 74B5 27644 29807 6BFC 746F
463 24001 3409 5DC1 0D51 32560 18580 7F30 4894 21564 26508 543C 678C

464 4862 16910 12FE 420E 2431 8455 097F 2107 5142 4442 1416 115A
465 14091 20739 370B 5103 19029 26301 4A55 66BD 1211 4871 04BB 1307

466 6702 10191 1A2E 27CF 3351 24027 0D17 5DDB 1203 31141 04B3 79A5
467 3067 12819 0BFB 3213 21549 22325 542D 5735 5199 9864 144F 2688

468 28643 19295 6FE3 4B5F 26145 27539 6621 6B93 16945 12589 4231 312D
469 21379 10072 5383 2758 30737 5036 7811 13AC 4883 5417 1313 1529

470 20276 15191 4F34 3B57 10138 21399 279A 5397 25040 8549 61D0 2165
471 25337 27748 62F9 6C64 24748 13874 60AC 3632 7119 14288 1BCF 37D0

472 19683 720 4CE3 02D0 30625 360 77A1 0168 17826 8503 45A2 2137
473 10147 29799 27A3 7467 16897 29711 4201 740F 4931 20357 1343 4F85

474 16791 27640 4197 6BF8 28955 13820 711B 35FC 25705 15381 6469 3C15
475 17359 263 43CF 0107 28727 20159 7037 4EBF 10726 18065 29E6 4691

476 13248 24734 33C0 609E 6624 12367 19E0 304F 17363 24678 43D3 6066
477 22740 16615 58D4 40E7 11370 28239 2C6A 6E4F 2746 23858 0ABA 5D32

478 13095 20378 3327 4F9A 18499 10189 4843 27CD 10952 7610 2AC8 1DBA
479 10345 25116 2869 621C 17892 12558 45E4 310E 19313 18097 4B71 46B1

480 30342 19669 7686 4CD5 15171 26710 3B43 6856 29756 20918 743C 51B6
481 27866 14656 6CDA 3940 13933 7328 366D 1CA0 14297 7238 37D9 1C46

482 9559 27151 2557 6A0F 17275 31547 437B 7B3B 21290 30549 532A 7755
483 8808 28728 2268 7038 4404 14364 1134 381C 1909 16320 0775 3FC0

484 12744 25092 31C8 6204 6372 12546 18E4 3102 8994 20853 2322 5175
485 11618 22601 2D62 5849 5809 25112 16B1 6218 13295 26736 33EF 6870

486 27162 2471 6A1A 09A7 13581 19183 350D 4AEF 21590 10327 5456 2857
487 17899 25309 45EB 62DD 29477 32594 7325 7F52 26468 24404 6764 5F54

488 29745 15358 7431 3BFE 27592 7679 6BC8 1DFF 13636 7931 3544 1EFB
489 31892 17739 7C94 454B 15946 27801 3E4A 6C99 5207 5310 1457 14BE

490 23964 12643 5D9C 3163 11982 22157 2ECE 568D 29493 554 7335 022A
491 23562 32730 5C0A 7FDA 11781 16365 2E05 3FED 18992 27311 4A30 6AAF

492 2964 19122 0B94 4AB2 1482 9561 05CA 2559 12567 6865 3117 1AD1
493 18208 16870 4720 41E6 9104 8435 2390 20F3 12075 7762 2F2B 1E52

494 15028 10787 3AB4 2A23 7514 23341 1D5A 5B2D 26658 15761 6822 3D91
495 21901 18400 558D 47E0 31510 9200 7B16 23F0 21077 12697 5255 3199

496 24566 20295 5FF6 4F47 12283 27039 2FFB 699F 15595 24850 3CEB 6112
497 18994 1937 4A32 0791 9497 19956 2519 4DF4 4921 15259 1339 3B9B

498 13608 17963 3528 462B 6804 27945 1A94 6D29 14051 24243 36E3 5EB3
499 27492 7438 6B64 1D0E 13746 3719 35B2 0E87 5956 30508 1744 772C

500 11706 12938 2DBA 328A 5853 6469 16DD 1945 21202 13982 52D2 369E

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

501 14301 19272 37DD 4B48 19006 9636 4A3E 25A4 11239 25039 2BE7 61CF

502 23380 29989 5B54 7525 11690 29870 2DAA 74AE 30038 24086 7556 5E16
503 11338 8526 2C4A 214E 5669 4263 1625 10A7 30222 21581 760E 544D

504 2995 18139 0BB3 46DB 21513 27985 5409 6D51 13476 21346 34A4 5362
505 23390 3247 5B5E 0CAF 11695 18539 2DAF 486B 2497 28187 09C1 6E1B

506 14473 28919 3889 70F7 19860 30279 4D94 7647 31842 23231 7C62 5ABF
507 6530 7292 1982 1C7C 3265 3646 0CC1 0E3E 24342 18743 5F16 4937

508 20452 20740 4FE4 5104 10226 10370 27F2 2882 25857 11594 6501 2D4A
509 12226 27994 2FC2 6D5A 6113 13997 17E1 36AD 27662 7198 6C0E 1C1E

510 1058 2224 0422 08B0 529 1112 0211 0458 24594 105 6012 0069
511 12026 6827 2EFA 1AAB 6013 17257 177D 4369 16790 4534 4196 11B6
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Test Equipment Preparation

Purpose

This appendix provides information on pre-testing set-up for the
following test equipment items (not required for the Cybertest test set):

� Agilent E4406A transmitter test set

� Agilent E4432B signal generator

� Advantest R3267 spectrum analyzer

� Advantest R3562 signal generator

� Agilent 8935 analyzer (formerly HP 8935)

� HP 8921 with PCS interface analyzer

� Advantest R3465 analyzer

� HP 437 power meter

� Gigatronics 8541C power meter

� GPIB adapter

Pre-testing set-up information covered includes verification and setting
GPIB addresses, inter-unit cabling, connectivity testing, pre-test control
settings, and equipment calibration for items which are not calibrated
with the Calibrate Test Equipment function of the LMF.
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Setting GPIB Addresses

Procedures for Verifying and Setting CDMA Support Equipment GPIB
Addresses

The following procedures cover verification and changing GPIB
addresses for the various items of CDMA test equipment supported by
the LMF.

Agilent E4406A Transmitter Tester GPIB Address
Figure F-1: Setting Agilent E4406A GPIB Address

System
Key

Bk Sp
Key

Enter
Key

Data Entry
Keypad

Softkey
Buttons

Softkey Label
Display Area

Active Function
Area

Refer to Figure F-1 and follow the procedure in Table F-1 to verify and,
if necessary, change the Agilent E4406A GPIB address.

Table F-1: Verify and Change Agilent E4406A GPIB Address

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Config I/O softkey button to the right of the instrument screen.

- The softkey labels will change.

- The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a - Press the GPIB Address softkey button.
-- In the on-screen Active Function Area, GPIB Address will be displayed followed by the

current GPIB address.

. . . continued on next page
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Table F-1: Verify and Change Agilent E4406A GPIB Address

Step Action

3b - On the front panel Data Entry keypad, enter the communications system analyzer GPIB address of
18.
-- The GPIB Address label will change to Enter.
-- Characters typed on the keypad will replace the current GPIB address in the Active Function

Area.

NOTE
To correct an entry, press the Bk Sp key at the upper right of the keypad to delete one character at a
time.

3c - Press the Enter softkey button or the keypad Enter key to set the new GPIB address.
-- The Config I/O softkey labels will reappear.
-- The new GPIB address will be displayed under the GPIB Address softkey label.

 

Agilent E4432B Signal Generator GPIB Address
Figure F-2: Setting Agilent E4432B GPIB Address
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Refer to Figure F-2 and follow the procedure in Table F-2 to verify and,
if necessary, change the Agilent E4432B GPIB address.

Table F-2: Verify and Change Agilent E4432B GPIB Address

Step Action

1 In the MENUS section of the instrument front panel, press the Utility key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the GPIB/RS232 softkey button to the right of the instrument screen.

- The softkey labels will change.

- The current instrument GPIB address will be displayed below the GPIB Address softkey label.

. . . continued on next page
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Table F-2: Verify and Change Agilent E4432B GPIB Address

Step Action

3 If the current GPIB address is not set to 1, perform the following to change it:

3a - Press the GPIB Address softkey button.
-- The GPIB Address label and current GPIB address will change to boldface.
-- In the on-screen Active Entry Area, Address: will be displayed followed by the current

GPIB address.

3b - On the front panel Numeric keypad, enter the signal generator GPIB address of 1.
-- The GPIB Address label will change to Enter.
-- Characters typed on the keypad will replace the current GPIB address in the Active Entry

display.

NOTE
To correct an entry, press the backspace key at the lower right of the keypad to delete one character at
a time.

3c - Press the Enter softkey button to set the new GPIB address.
-- The new GPIB address will be displayed under the GPIB Address softkey label.

 

Advantest R3267 Spectrum Analyzer GPIB Address

Figure F-3: Setting Advantest R3267 GPIB Address
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Refer to Figure F-3 and perform the procedure in Table F-3 to verify
and, if necessary, change the Advantest R3267 spectrum analyzer GPIB
address.
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Table F-3: Verify and Change Advantest R3267 GPIB Address

Step Action

1 If the REMOTE LED is lighted, press the LCL key.

- The LED extinguishes.

2 Press the CONFIG key.

- The CONFIG softkey labels will appear in the softkey label display area of the instrument
display.

- The current GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a - Press the GPIB Address softkey.
-- A GPIB Address entry window will open in the instrument display showing the current

GPIB address.

3b - Enter 18 on the keypad in the ENTRY section of the instrument front panel.
-- Characters typed on the keypad will replace the address displayed in the GPIB Address

entry window.

NOTE
To correct an entry, press the BS (backspace) key at the lower right of the keypad to delete one
character at a time.

3c - Press the ENTR key to the lower right of the keypad to set the new GPIB address.
-- The GPIB Address entry window closes.
-- The new address is displayed in the bottom portion of the GPIB Address softkey label.

 

Advantest R3562 Signal Generator GPIB Address

Set the GP-IB ADDRESS switch on the rear of the Advantest R3562
signal generator to address 1 as shown in Figure F-4.

Figure F-4: Advantest R3562 GPIB Address Switch Setting

1 2 3 4 5 6 7 8

5 4 3 2 1

GP-IP  ADDRESS

1

0

GPIB Address set to “1”
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Agilent 8935 Series E6380 (formerly HP 8935) Test Set GPIB Address

Figure F-5: Agilent 8935 Test Set

Preset

Cursor ControlShift

Inst Config

Local

FW00885

Refer to Figure F-5 and follow the procedure in Table F-4 to verify and,
if necessary, change the Agilent 8935 GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-4: Verify and/or Change Agilent 8935 (formerly HP 8935) GPIB Address

Step Action

1 NOTE
The HP I/O configuration MUST be set to Talk & Listen, or no device on the GPIB will be
accessible. (Consult test equipment OEM documentation for additional information as required.)

To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the Agilent 8935.

- The current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.

2 If the current GPIB address is not set to 18, perform the following to change it:

2a - Press Shift and Inst Config.

2b - Turn the Cursor Control knob to move the cursor to the HP-IB Adrs field.

2c - Press the Cursor Control knob to select the field.

2d - Turn the Cursor Control knob as required to change the address to 18.

2e - Press the Cursor Control knob to set the address.

3 Press Preset to return to normal operation.
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Setting HP 8921A and HP 83236A/B GPIB Address

Figure F-6: HP 8921A and HP 83236A/B

Preset

Cursor ControlShift

Local

Refer to Figure F-6 and follow the procedure in Table F-5 to verify and,
if necessary, change the HP 8921A HP 83236A GPIB addresses.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-5: Verify and/or Change HP 8921A and HP 83236A GPIB Addresses

Step Action

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP 8921A.

- The current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.

2 If the current HP-IB address is not set to 18, perform the following to change it:

2a - Turn the Cursor Control knob to move the cursor to More and press the knob to select the field.

2b - Turn the Cursor Control knob to move the cursor to I/O Config and press the knob to select the
field.

2c - Turn the Cursor Control knob to move the cursor to Adrs and press the knob to select the field.

2d - Turn the Cursor Control knob to change the HP-IB address to 18 and press the knob to set the
address.

F



Setting GPIB Addresses68P09255A69-3

Aug 2002 1X SC�4812ET Lite BTS Optimization/ATP Software Release 2.16.1.x

PRELIMINARY
F-9

Table F-5: Verify and/or Change HP 8921A and HP 83236A GPIB Addresses

Step Action

2e - Press Shift and Preset to return to normal operation.

3 To set the HP 83236A (or B) PCS Interface GPIB address=19, set the DIP switches as follows:

- A1=1, A2=1, A3=0, A4=0, A5=1, HP-IB/Ser = 1

Advantest R3465 GPIB Address

Figure F-7: R3465 Communications Test Set
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Refer to Figure F-7 and follow the procedure in Table F-6 to verify and,
if necessary, change the GPIB address for the Advantest R3465.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-6: Verify and/or Change Advantest R3465 GPIB Address

Step Action

1 To verify that the GPIB address is set correctly, perform the following:

1a - Press SHIFT then PRESET.

1b - Press LCL.

1c - Press the GPIB and Others CRT menu key to view the current address.

2 If the current GPIB address is not set to 18, perform the following to change it:

2a - Turn the vernier knob as required to select 18.

2b - Press the vernier knob to set the address.

3 To return to normal operation, press Shift and Preset.
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Motorola CyberTest GPIB Address

Follow the steps in Table F-7 to verify and, if necessary, change the
GPIB address on the Motorola CyberTest. Changing the GPIB address
requires the following items:

� Motorola CyberTest communications analyzer.

� Computer running Windows 3.1/Windows 95.

� Motorola CyberTAME software program “TAME”.

� Parallel printer port cable (shipped with CyberTest).

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-7:  Verify and/or Change Motorola CyberTest GPIB Address

Step Action

1 On the LMF desktop, locate the CyberTAME icon. Double click on the icon to run the CyberTAME
application.

2 In the CyberTAME window taskbar, under Special, select IEEE.488.2.

3 CyberTAME software will query the CyberTest Analyzer for its current GPIB address. It then will
open the IEEE 488.2 dialog box. If the current GPIB address is not 18, perform the following
procedure to change it:

3a - Use the up or down increment arrows or double-click in the field and type the number to set the
address to 18.

3b - Click on the OK button.
-- The new address will be written to the CyberTest through the parallel port and saved.

4 Verify that the address has been set by repeating steps 2 and 3.

- The new address should now appear in the IEEE 488.2 dialog box Address field.
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HP 437 Power Meter GPIB Address

Figure F-8: HP 437 Power Meter
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Refer to Figure F-8 and follow the steps in Table F-8 to verify and, if
necessary, change the HP 437 GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-8: Verify and/or Change HP 437 Power Meter GPIB Address

Step Action

1 Press Shift and PRESET.

2 Use the � arrow  key to navigate to HP-IB ADRS and press ENTER.

The HP-IB address is displayed.

NOTE
HP-IB is the same as GPIB.

3 If the current GPIB address is not set to 13, perform the following to change it:

- Use the � 
 arrow keys to change the HP-IB ADRS to 13.

- Press ENTER to set the address.

4 Press Shift and ENTER to return to a standard configuration.
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Gigatronics 8541C Power Meter GPIB Address

Figure F-9: Gigatronics 8541C Power Meter Detail
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Refer to Figure F-9 and follow the steps in Table F-9 to verify and, if
necessary, change the Gigatronics 8541C power meter GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-9: Verify and/or Change Gigatronics 8541C Power Meter GPIB Address

Step Action

1 ! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

Press MENU.

2 Use the 
 arrow key to select CONFIG MENU and press ENTER.

3 Use the 
 arrow key to select GPIB and press ENTER.

The current Mode and GPIB Address are displayed.

4 If the Mode is not set to 8541C, perform the following to change it:

Use the � 	 arrow keys as required to select MODE.

Use the 
� arrow keys as required to set MODE to 8541C.

5 If the GPIB address is not set to 13, perform the following to change it:

Use the 	 arrow key to select ADDRESS.

Use the 
� arrow keys as required to set the GPIB address to 13.

6 Press ENTER to return to normal operation.
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RS-232  GPIB Interface Adapter

Be sure that the RS-232 GPIB interface adapter DIP switches are set as
shown in Figure F-10.

Figure F-10: RS232 GPIB Interface Adapter
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Test Equipment Inter-unit Connection, Testing, and Control

Inter-unit  Connection, Testing, and Control Settings

The following illustrations, tables, and procedures provide the
information necessary to prepare various items of CDMA test equipment
supported by the LMF for BTS calibration and/or acceptance testing.

HP 8921A with PCS Interface Test Equipment Connections

The following diagram depicts the rear panels of the HP 8921A test
equipment as configured to perform automatic tests. All test equipment
is controlled by the LMF via an IEEE-488/GPIB bus. The LMF expects
each piece of test equipment to have a factory-set GPIB address (refer to
Table F-5 and Figure F-6). If there is a communications problem
between the LMF and any piece of test equipment, verify that the GPIB
addresses have been set correctly and that the GPIB cables are firmly
connected to the test equipment.

Figure F-11 shows the connections when not using an external 10 MHz
Rubidium reference.

Table F-10: HP 8921A/600 Communications Test Set Rear Panel Connections Without Rubidium Reference

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC-female - SMC-female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC-female - SMC-female

IQ RF IN IQ RF OUT SMC-female - SMC-female

DET OUT AUX DSP IN SMC-female - SMC-female

CONTROL I/O CONTROL I/O 45-pin custom BUS

10 MHZ OUT SYNTH REF IN BNC-male - BNC-male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ OUT REF IN BNC-male - BNC-male
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Figure F-11: HP 8921A/600 Cable Connections for 10 MHz Signal and GPIB without Rubidium Reference
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Figure F-12 shows the connections when using an external 10 MHz
Rubidium reference.

Table F-11: HP 8921A/600 Communications Test Set Rear Panel Connections With Rubidium Reference

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC-female - SMC-female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC-female - SMC-female

IQ RF IN IQ RF OUT SMC-female - SMC-female

DET OUT AUX DSP IN SMC-female - SMC-female

CONTROL I/O CONTROL I/O 45-pin custom BUS

10 MHZ OUT REF IN BNC-male - BNC-male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ INPUT 10 MHZ OUT BNC-male - BNC-male
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Figure F-12: HP 8921A Cable Connections for 10 MHz Signal and GPIB with Rubidium Reference
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HP 8921A with PCS Interface System Connectivity Test

Follow the steps outlined in Table F-12 to verify that the connections
between the PCS Interface and the HP 8921A are correct and cables are
intact. The software also performs basic functionality checks of each
instrument.

NOTE Table:note.  Note 10pt Helvetica
Disconnect other GPIB devices, especially system controllers,
from the system before running the connectivity software.

Table F-12: System Connectivity

Step Action

NOTE
- Perform this procedure after test equipment has been allowed to warm-up and stabilize for a

minimum of 60 minutes.

1 Insert HP 83236A Manual Control/System card into memory card slot.

2 Press the [PRESET] pushbutton.

3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.

4 Position the cursor at Select Procedure Location and select it by pressing the cursor control knob. In
the Choices selection box, select Card.

5 Position the cursor at Select Procedure Filename and select it by pressing the cursor control knob. In
the Choices selection box, select SYS_CONN.

6 Position the cursor at RUN TEST and select it. The software will provide operator prompts through
completion of the connectivity setup.

7 Do the following when the test is complete,

� position cursor on STOP TEST and select it

� OR press the [K5] pushbutton.

8 To return to the main menu, press the [K5] pushbutton.

9 Press the [PRESET] pushbutton.

Pretest Setup for HP 8921A

Before the HP 8921A CDMA analyzer is used for LMF-controlled
testing it must be set up correctly for automatic testing.

Table F-13: Pretest Setup for HP 8921A

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the CURSOR CONTROL knob.

3 Position the cursor at IO CONFIG (under To Screen and More) and select it.

4 Select Mode and set for Talk&Lstn.
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Pretest Setup for Agilent 8935

Before the Agilent 8935 analyzer is used for LMF controlled testing it
must be set up correctly for automatic testing.

Table F-14: Pretest Setup for Agilent 8935

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the Shift button and then press the I/O Config button.

3 Press the Push to Select knob.

4 Position the cursor at IO CONFIG and select it.

5 Select Mode and set for Talk&Lstn.
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Advantest R3465 Connection

The following diagram depicts the rear panels of the Advantest R3465
test equipment as configured to perform automatic tests. All test
equipment is controlled by the LMF via an IEEE-488/GPIB bus. The
LMF expects each piece of test equipment to have a factory-set GPIB
address (refer to Table F-6 and Figure F-7). If there is a communications
problem between the LMF and any piece of test equipment, verify that
the GPIB addresses have been set correctly and that the GPIB cables are
firmly connected to the test equipment.

Figure F-13 shows the connections when not using an external 10 MHz
Rubidium reference.

Figure F-13: Cable Connections for Test Set without 10 MHz Rubidium Reference
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Figure F-14 shows the connections when using an external 10 MHz
Rubidium reference.

Figure F-14: Cable Connections for Test Set with 10 MHz Rubidium Reference
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R3465 GPIB Clock Set-up

Table F-15 describes the steps to set the clock for the Advantest R3465
equipment.

Table F-15: Advantest R3465 Clock Setup

Step Action

1 Observe the current date and time displayed in upper right of the CRT display.

2 If the date and time are incorrect, perform the following to change them:

2a - Push the Date/Time CRT menu key.

2b - Rotate the vernier knob to select and set.

2c - Push the vernier knob to enter.

2d - Push the SHIFT then PRESET pushbutton (just below the CRT display).
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Pretest Setup for Advantest R3465

Before the Advantest R3465 analyzer is used for LMF-controlled testing
it must be set up correctly for automatic testing.

Table F-16: Pretest Setup for Advantest R346

Step Action

1 Press the SHIFT button so the LED next to it is illuminated.

2 Press the RESET button.

Agilent 8932/E4432B Test Equipment Interconnection

To perform FER testing on a 1X BTS with the Agilent 8935, a
1X-capable signal generator, such as the Agilent E4432B, must be used
in conjunction with the CDMA base station test set. For proper
operation, the test equipment items must be interconnected as follows:

10 MHz reference signal - Connect a BNC (M)-BNC (M) cable from
the 8935 10 MHz REF OUT connector to the E4432B 10MHz IN
connector as shown in Figure F-15

Even second pulse reference - Refer to Figure F-15, and connect a
BNC “T” connector to the 8935 EVEN SEC SYNC IN connector.
Connect a BNC (M)-BNC (M) cable from one side of the BNC “T” to
the E4432B PATTERN TRIG IN connector. Connect the other side of
the BNC “T” to the CSM board SYNC MONITOR connector using a
BNC (M)-BNC (M) cable.

Figure F-15: Agilent 8935/E4432B 10MHz Reference and Even Second Tick Connections
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Agilent E4406A/E4432B Test Equipment Interconnection

To provide proper operation during testing when both units are required,
the 10 MHz reference signal from the E4406A transmitter test set must
be provided to the E4432B signal generator. Connect a BNC (M)-BNC
(M) cable from the E4406A 10 MHz OUT (SWITCHED) connector to
the E4432B 10MHz IN connector as shown in Figure F-16.

Figure F-16: Agilent 10 MHz Reference Connections
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Advantest R3267/R3562 Test Equipment Interconnection

To provide proper operation during testing when both units are required,
the R3257 spectrum analyzer must be interconnected with the R3562
signal generator as follows:

10 MHz reference signal - Connect a BNC (M)-BNC (M) cable
between the R3562 SYNTHE REF IN connector and the R3267 10
MHz OUT connector as shown in Figure F-17.

Serial I/O - Using the Advantest cable provided, connect the R3267
SERIAL I/O connector to the R3562 SERIAL I/O connector as shown
in Figure F-17.

Figure F-17: Advantest 10 MHz Reference and Serial I/O Connections
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Equipment Calibration

Calibration Without the LMF

Several test equipment items used in the optimization process require
pre-calibration actions or calibration verification which are not
supported by the LMF. Procedures to perform these activities for the
applicable test equipment items are covered in this section.

Agilent E4406A Transmitter Tester Self-alignment (Calibration)

System
Key

Softkey
Buttons

Softkey Label
Display Area

g Agilent E4406A
tion)

Refer to Figure F-18 and follow the procedure in Table F-17 to perform
the Agilent E4406A self-alignment (calibration).

Table F-17: Perform Agilent E4406A Self-alignment (Calibration)

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Alignments softkey button to the right of the instrument screen.

- The softkey labels will change.

3 Press the Align All Now softkey button.

- All other instrument functions will be suspended during the alignment.

- The display will change to show progress and results of the alignments performed.

- The alignment will take less than one minute.
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Calibrating HP 437 Power Meter

Precise transmit output power calibration measurements are made using
a bolometer-type broadband power meter with a sensitive power sensor.
Follow the steps outlined in Table F-18 to enter information unique to
the power sensor before calibrating the test setup. Refer to Figure F-19
as required.

NOTE This procedure must be done before the automated calibration to
enter power sensor specific calibration values.

Figure F-19: Power Meter Detail
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Table F-18: HP 437 Power Meter Calibration Procedure

Step Action

1 ! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or mis-calibration.

Make sure the power meter AC LINE pushbutton is OFF.

2 Connect the power sensor cable to the SENSOR input.

3 Set the AC LINE pushbutton to ON.

NOTE
The calibration should be performed only after the power meter and sensor have been allowed to
warm-up and stabilize for a minimum of 60 minutes.

4 Perform the following to set or verify the correct power sensor model:

4a - Press [SHIFT]  then [�] to select SENSOR.

4b - Identify the power sensor model number from the sensor label.

4c - Use the [�] or [
] button to select the appropriate model; then press [ENTER].

5 Refer to the illustration for step 8, and perform the following to ensure the power reference output is
OFF:

5a - Observe the instrument display and determine if the triangular indicator over PWR REF is
displayed.

5b - If the triangular indicator is displayed, press [SHIFT] then [	] to turn it off.

. . . continued on next page
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Table F-18: HP 437 Power Meter Calibration Procedure

Step Action

6 Press [ZERO].

- Display will show “Zeroing ******.”

- Wait for process to complete.

7 Connect the power sensor to the POWER REF output.

8 Turn on the PWR REF by performing the following:

8a - Press [SHIFT] then [	].

8b - Verify that the triangular indicator (below) appears in the display above PWR REF.

9 Perform the following to set the REF CF%:

9a - Press ([SHIFT] then [ZERO]) for CAL.

9b - Enter the sensor’s REF CF% from the sensor’s decal using the arrow keys and press [ENTER].
(The power meter will display ”CAL *****” for a few seconds.)

NOTE
If the REF CAL FACTOR (REF CF) is not shown on the power sensor, assume it to be 100%.

10 Perform the following to set the CAL FAC %:

10a - Press [SHIFT] then [FREQ] for CAL FAC.

10b - On the sensor’s decal, locate an approximate calibration percentage factor (CF%) at 2 GHz.

10c - Enter the sensor’s calibration % (CF%) using the arrow keys and press [ENTER].
-- When complete, the power meter will typically display 0.05 dBm. (Any reading between

0.00 and 0.10 is normal.)

11 To turn off the PWR REF, perform the following:

11a - Press [SHIFT] then [	].

11b - Disconnect the power sensor from the POWER REF output.
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Calibrating Gigatronics 8541C Power Meter

Precise transmit output power calibration measurements are made using
a bolometer-type broadband power meter with a sensitive power sensor.
Follow the steps in Table F-19 to enter information unique to the power
sensor.

Table F-19: Calibrate Gigatronics 8541C Power Meter

Step Action

1 ! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

Make sure the power meter POWER pushbutton is OFF.

2 Connect the power sensor cable to the SENSOR input.

3 Set the POWER pushbutton to ON.

NOTE
Allow the power meter and sensor to warm up and stabilize for a minimum of 60 minutes before
performing the calibration procedure.

4 Connect the power sensor to the CALIBRATOR output connector.

5 Press ZERO.

- Wait for the process to complete. Sensor factory calibration data is read to power meter during this
process.

6 When the zeroing process is complete, disconnect the power sensor from the CALIBRATOR output.

Figure F-20: Gigatronics 8541C Power Meter Detail
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Manual Cable Calibration

Calibrating Test Cable Setup
Using HP PCS Interface (HP83236)

Table F-20 covers the procedure to calibrate the test equipment using the
HP8921 Cellular Communications Analyzer equipped with the HP83236
PCS Interface.

NOTE This calibration method must be executed with great care. Some
losses are measured close to the minimum limit of the power
meter sensor (-30 dBm).

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

Table F-20: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

1 Insert HP83236 Manual Control System card into memory card slot.

2 Press the Preset pushbutton.

3 Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

4 Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

6 Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

7 If using HP83236A:
Set channel number=<chan#>:

- Position cursor at Channel
Number and select it.

- Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank.

- When the screen reappears, the
chan# will be displayed on the
channel number line.

If using HP83236B:
Set channel frequency:

- Position cursor at Frequency Band and press Enter.

- Select User Defined Frequency.

- Go Back to Previous Menu.

- Position the cursor to 83236 generator frequency and
enter actual RX frequency.

- Position the cursor to 83236 analyzer frequency and
enter actual TX frequency.

8 Set RF Generator level:

- Position the cursor at RF Generator Level and select it.

- Enter -10  using the numeric keypad; press [Enter] and the screen will go blank.

- When the screen reappears, the value -10 dBm will be displayed on the RF Generator Level line.

. . . continued on next page
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Table F-20: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

9 Set the user fixed Attenuation Setting to 0 dBm:

- Position cursor at Analyzer Attenuation and select it
- Position cursor at User Fixed Atten Settings and select it.

- Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:

- Position cursor at Show Frequency and Level Details and select it.
- Under HP83236 Frequencies and Levels, record the Generator Level.
- Under HP83236B Frequencies and Levels, record the Generator Frequency Level (1850 - 1910

MHz).

- Position cursor at Prev Menu and select it.

12 Click on Pause for Manual Measurement.

13 Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14 On the HP8921A, under To Screen, select CDMA GEN.

15 Move the cursor to the Amplitude field and click on the Amplitude value.

16 Increase the Amplitude value until the power meter reads 0 dBm ±0.2 dB.

NOTE
The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17 Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.

NOTE
The Power Meter sensor’s lower limit is -30 dBm. Thus, only components having losses ≤30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18 Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor. Record the
calibrated loss value displayed on the power meter.

� Example: (A) Test Cable(s) = -1.4 dB
(B) 20 dB Attenuator = -20.1 dB
(B) Directional Coupler = -29.8 dB

19 After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:
� Example: Total test setup loss = -1.4 -29.8 -20.1 = -51.3 dB.

This calculated value will be used in the next series of tests.

20 Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21 Select Continue (K2).

22 Select RF Generator Level and set to -119 dBm.

. . . continued on next page
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Table F-20: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

23 Click on Pause for Manual Measurement.

24 Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

� Verify the GPIB (HP-IB) address:

- under To Screen, select More

- select IO CONFIG

- Set HP-IB Adrs to 18

- set Mode to Talk&Lstn

� Verify the HP8921A is displaying frequency (instead of RF channel)

- Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

- Use the cursor control to set RF Display to Freq

25 Refer toChapter 3 for assistance in setting the cable loss values into the LMF.
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Figure F-21: Cable Calibration Using HP8921 with PCS Interface
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Calibrating Test Cable Setup Using Advantest R3465

NOTE Be sure the GPIB Interface is OFF for this procedure.

Advantest R3465 Manual Test setup and calibration must be performed
at both the TX and RX frequencies.

Table F-21: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

* IMPORTANT
- This procedure can only be performed after test equipment has been allowed to warm-up and

stabilize for a minimum of 60 minutes.

1 Press the SHIFT and the PRESET keys located below the display

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 Select the CDMA Sig CRT menu key

4 Select the Setup CRT menu key

5 Using the vernier knob and the cursor keys set the following parameters

NOTE
Fields not listed remain at default

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

6 Select the return CRT menu key

7 Press FREQ key in the ENTRY area

8 Set the frequency to the desired value using the keypad entry keys

9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 Verify that the Output CRT menu key is highlighting OFF; if not, press the Output key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 Set the LEVEL to 0 dBm using the key pad entry keys.

13 Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 Press the Output CRT menu key to toggle Output to ON.

15 Record the power meter reading  ________________________

. . . continued on next page
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Table F-21: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

16 Disconnect the power meter sensor from the R3561L RF OUT jack.

* IMPORTANT
The Power Meter sensor’s lower limit is -30 dBm.  Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re-zero the power meter before
connecting the power sensor to the component being calibrated.  Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 Disconnect all components in the the test setup and calibrate each one separately.  Connect each
component one-at-a-time between the “RF OUT” port and the power sensor (see Figure F-22,
“Setups A, B, and C”).  Record the calibrated loss value displayed on the power meter for each
connection.

Example: (A) 1st Test Cable =  -0.5 dB
(B) 2nd Test Cable =  -1.4 dB
(C) 20 dB Attenuator =  -20.1 dB
(D) 30 dB Directional Coupler =  -29.8 dB

18 Press the Output CRT menu key to toggle Output OFF.

19 Calculate the total test setup loss by adding up all the individual losses:

Example: Total test setup loss  =  0.5 + 1.4 + 20.1 + 29.8  =  51.8 dB

This calculated value will be used in the next series of tests.

20 Press the FREQ key in the ENTRY area

21 Using the keypad entry keys, set the test frequency to the RX frequency

22 Repeat steps 9 through 19 for the RX frequency.

23 Refer to Chapter 3 for assistance in setting the cable loss values into the LMF.
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Figure F-22: Cable Calibration Using Advantest R3465
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Notes
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Downloading ROM Code

Exception Procedure - Downloading ROM Code

This procedure is not part of a normal optimization.

Perform this procedure only on an exception basis when no alternative
exists to load a BTS device with the correct version of ROM code.

NOTE One GLI must be INS_ACT (bright green) before ROM code
can be downloaded to non-GLI devices.

CAUTION The correct ROM and RAM codes for the software release used
on the BSS must be loaded into BTS devices. To identify the
correct device ROM and RAM code loads for the software
release being used on the BSS, refer to the Version Matrix
section of the SC� CDMA Release Notes (supplied on the tapes
or CD-ROMs containing the BSS software).

All devices in a BTS must be loaded with the ROM and RAM
code specified for the software release used on the BSS before
any optimization or ATP procedures can be performed.

If a replacement device is loaded with ROM code which is not
compatible with the BSS software release being used, the device
ROM code can be changed using the LMF before performing the
BTS optimization and ATPs. A device loaded with later release
ROM code can not be converted back to a previous release ROM
code in the field without Motorola assistance

If it is necessary to download ROM code to a device from the LMF, the
procedure in Table G-1 includes steps for both ROM and RAM code
download using the LMF.

Prerequisites

Prior to performing this procedure, ensure the correct ROM and RAM
code files exist in the LMF computer’s applicable <x>:\<lmf home
directory>\cdma\loads\<codeload#>\code folder for each of the devices
to be loaded (refer to Table 3-3).

CAUTION The Release level of the ROM code to be downloaded must be
the one specified for the software release installed in the BSS.
The release level of the ROM code resident in the other devices
in the BTS must also be correct for the BSS software release
being used. ROM code must not be downloaded to a frame
loaded with code for a BSS software release with which it is not
compatible.

This procedure should only be used to upgrade replacement
devices for a BTS. It should NOT be used to upgrade all devices
in a BTS. If a BTS is to be upgraded from R15.x to R16.0, the
upgrade should be done by the OMC-R using the DownLoad
Manager.
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Table G-1: Download ROM and RAM Code to Devices

Step Action

1 Click on the device to be loaded.

NOTE
More than one device of the same type can be selected for download by either clicking on each one to
be downloaded or from the BTS menu bar Select pull-down menu, select the device item that applies.

Where:  device  =  the type of device to be loaded (BBX, CSM, GLI, MCC)

2 From the BTS menu bar Device pull-down menu, select Status.

- A status report window will appear.

3 Make a note of the number in the HW Bin Type column.

NOTE
“HW Bin Type” is the Hardware Binary Type for the device. This code is used as the last four digits in
the filename of a device’s binary ROM code file. Using this part of the filename, the ROM code file
can be matched to the device in which it is to be loaded.

4 Click OK to close the status window.

5 Click on the device to be loaded.

NOTE
ROM code is automatically selected for download from the <x>:\<lmf home
directory>\version folder>\<code folder> specified by the NextLoad property in
the bts-#.cdf file. To check the value of the NextLoad property, click on Util > Examine >
Display Nextload. A pop-up message will show the value of the NextLoad.

6 From the BTS menu bar Device pull-down menus, select Download > ROM.

- If the file matching the Hardware Binary Type of the device is found in the code folder, a status
report shows the result of the download. Proceed to Step 11.

- If a file selection window appears, select the ROM code file manually.

7 Double-click on the version folder with the desired version number for the ROM code file (for
example 2.16.0.x).

8 Double-click the Code folder.

- A list of ROM and RAM code files will be displayed.

9 ! CAUTION
A ROM code file with the correct HW Bin Type must be chosen. Using a file with the wrong HW Bin
Type can result in unpredictable operation and damage to the device.

Click on the ROM code file with the filename which matches the device type and HW Bin Type
number noted in step 3 (for example, file bbx_rom.bin.0604 is the ROM code file for a BBX with a
HW Bin Type of 0604).

- The file should be highlighted.

10 Click on the Load button.

- A status report window is displayed showing the result of the download.

NOTE
If the ROM load failed for some devices, load them individually by clicking on one device, perform
steps 6 through 10 for it, and repeat the process for each remaining device.

11 Click OK to close the status window.
. . . continued on next page
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Table G-1: Download ROM and RAM Code to Devices

Step Action

12 From the LMF window menu bar Tools pull-down menus, select Update NextLoad > CDMA.

13 In the left-hand pane of the window which opens, click on the BTS number for the frame being loaded
(for example, BTS-14 ).

14 On the list of versions displayed in the right-hand pane, click the button next to the version number of
the folder that was used for the ROM code download (for example, 2.16.0.x) and click Save.

- A pop-up message will appear showing the CDF has been updated.

15 Click on the OK button to dismiss the pop-up message.

16 Click on the device that was loaded with ROM code.

17 NOTE
RAM code is automatically selected for download.

From the BTS menu bar Device pull-down menus, select Download > Code/Data to download RAM
code and dds file data.

- A status report is displayed showing the result of the download.

18 Click OK to close the status window.

19 Observe the downloaded non-GLI device to ensure it is OOS_RAM (yellow).

20 Click on the device which was loaded with code.

21 From the BTS menu bar Device pull-down menu, select Status.

Verify that the correct ROM and RAM version numbers are displayed in the status report window.

22 Click OK to close the status window.
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Introduction

Purpose
This procedure is a guide to performing calibration of new BTS
expansion carriers while the system remains in service. This procedure
also supports BTS recalibration following replacement of RF chain
components while the remainder of the site stays in service.

Motorola recommends performing this procedure during a maintenance
window.

This procedure cannot be performed on BTSs with 2-to-1 combiners.
The procedure can only be performed on one carrier of the BTS at a
time. That is, LPAs 1A, 1B, 1C, and 1D can be calibrated while LPAs
3A, 3B, 3C, and 3D remain in service and vice versa.

Equipment Stabilization and Calibration

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test equipment set. Calibrate the test equipment after it
has been allowed to warm-up and stabilize for a minimum of 60
minutes.

CAUTION If any component of the test equipment set (for example, a test
cable, RF adapter, signal generator) has been replaced, the test
equipment set must be recalibrated. Failure to do so could
introduce measurement errors which ultimately result in
degradation of system performance.

1X Test Equipment Requirements
In-Service  Calibration (ISC) of 1X carrier functions requires using the
following test equipment for the purposes indicated:

� An Advantest R3267 spectrum analyzer to perform TX calibration

� An Advantest R3562 signal generator for R3267 Delta Power
Calibration

� An Agilent E4406A Transmitter Test Set to perform TX calibration

� An Agilent E4432A signal generator for E4406A Delta Power
Calibration

� An Agilent 8935 series E6380A equipped with option 200 (if
purchased new) or option R2K (if retrofitted) to perform TX
calibration

The CDMA communications system analyzers listed above are capable
of calibrating the BTS for both IS-95 A and B mode operation as well as
CDMA2000 1X operation.

NOTE IS-95A/B communication test sets such as the HP8921A/600
and Advantest R3561L can not calibrate 1X carrier functions.

Calibration and test set-up for the HP 8921A/600 and Advantest
R3561L test sets is included only for situations where it is necessary to
use them for calibration of IS-95A/B mode operation.
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Power Delta Calibration

Introduction

The ISC procedure has several differences from a normal calibration
procedure. One of these is the use of a spectrum
analyzer/communications test set instead of a power meter to measure
power. Power meters are broadband measurement devices and cannot be
used to measure power during ISC because other carriers are operating.
A spectrum analyzer can be used because it measures power at a given
frequency. Measuring power using a spectrum analyzer is less accurate
than using a power meter, therefore, compensation is required for the
accuracy difference (delta) between the power meter and the spectrum
analyzer.

Agilent E4406A Power Delta Calibration

The Agilent E4406A transmitter tester and E4432B signal generator test
equipment combination can be used for ISC of IS-2000 CDMA 1X as
well as IS-95A/B operation modes. The power delta calibration is
performed on the E4406A, but the E4432B is required to generate the
reference signal used to calculate the power delta offset. After the offset
value has been calculated, add it to the TX cable loss value in the LMF.

Preliminary Agilent Test Equipment Set-up

To provide proper operation during power delta calibration, be sure the
E4406A and E4432B are connected as shown in Figure F-16.

Power Delta Calibration

Follow the procedure in Table H-1 to perform the Agilent E4406A
Power Delta Calibration procedure.

Table H-1: Agilent E4406A Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter NO TAG.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

2 Be sure the E4406A and E4432B are connected as shown in Figure F-16.

3 Connect a short RF cable from the E4432B RF OUTPUT connector the HP437 power meter power
sensor (see Figure H-1).

. . . continued on next page

H



Power Delta Calibration 68P09255A69-3

Aug 20021X SC�4812ET Lite BTS Optimization/ATP Software Release 2.16.1.x
PRELIMINARY

H-4

Table H-1: Agilent E4406A Power Delta Calibration Procedure

Step Action

4 Set the E4432B signal generator as follows:

- Press  Preset  to exit any modes for which the signal generator is configured

- Press  Frequency  and enter the frequency of the channel to be calibrated on the numeric keypad

- Using the soft keys to the right of the screen, select the frequency range to be measured; for
example  MHz

- Press  Amplitude  and, using the numeric keypad, set signal amplitude to  0 (zero)

- Using the soft keys, set the measurement type to  dBm

5 On the E4432B, press RF On/Off to toggle the RF output to  RF ON.

- Note that the RF On/Off status in the screen display changes.

6 Measure and record the value reading on the HP437 power meter as result A____________________.

7 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

- Note that the RF On/Off status in the screen display changes.

8 Disconnect the short RF cable from the HP437 power meter power sensor, and connect it to the RF
INPUT connector on the E4406A transmitter tester (see Figure H-2).

9 NOTE
Do not change the frequency and amplitude settings on the E4432B when performing the following
steps.

Set the E4406A as follows:

- Press  Preset  to exit any modes for which the transmitter tester is configured

- Press  MODE  and, using the soft keys to the right of the screen, select  cdmaOne

- Press  MEASURE  and, using the soft keys, select  spectrum

- Press  Frequency  and, using the soft keys, select  Center Frequency

- Enter the frequency of the channel to be calibrated using the numeric keypad

- Using the soft keys, select the frequency range to be measured; for example,  MHz

- Press Input/Output and, using the soft keys, select  Input Atten

- Using the numeric keypad, set Input Atten  to  0 (zero) and, using the soft keys, select  dB

- Using the soft keys, select  External Atten  and then select Mobile
- Using the numeric keypad, set Mobile to  0 (zero) and, using the soft keys, select  dB

- Using the soft keys, select  Base

- Using the numeric keypad, set Base to  0 (zero) and, using the soft keys, select  dB

- Press  MEASURE  and, using the soft keys, select  Channel Power

10 On the E4432B signal generator, press RF On/Off to toggle the RF output to  RF ON.

- Note that the RF On/Off status in the screen display changes.

11 Read the measured Channel Power from the E4406A screen display and record it as 
result B____________________.

12 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

- Note that the RF On/Off status in the screen display changes.

. . . continued on next page
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Table H-1: Agilent E4406A Power Delta Calibration Procedure

Step Action

13 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Agilent measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see step 4 in
Table H-6).

 

Figure H-1: Delta Calibration Setup - Agilent E4432B to HP437
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Advantest R3267 Power Delta Calibration
The Advantest R3267 spectrum analyzer and R3562 signal generator test
equipment combination can be used for ISC of IS-2000 CDMA 1X as
well as IS-95A/B operation modes. The power delta calibration is
performed on the R3267. After the offset value has been calculated, add
it to the TX cable loss value.

Preliminary Advantest Test Equipment Set-up

To provide proper operation during power delta calibration, be sure the
R3267 is connected to the R3562 as shown in Figure F-17.

Power Delta Calibration

Follow the procedure in Table H-2 to perform the Advantest R3267
Power Delta Calibration procedure.

Table H-2: Advantest R3267 Power Delta Calibration Procedure

Step Action

1 NOTE
Warm-up test equipment for a minimum of 60 minutes prior to this procedure. After it is warmed up
and stabilized, calibrate the test equipment as described in the “Test Set Calibration” section of
Chapter NO TAG.

Be sure the R3267 and R3562 are connected as shown in Figure F-17.

2 Press the SHIFT and the PRESET keys located on the right side of the control panel.

3 Press the ADVANCE key in the MEASUREMENT area of the control panel.

4 On the CRT, select RX Control by pressing ACTIVE key 1.

5 On the CRT, select Frequency Setup by pressing ACTIVE key 3.

6 On the CRT, highlight Frequency by adjusting the DISPLAY CONTROL knob.

7 Press FREQ key in the ENTRY section of the control panel.

8 Set the frequency to the desired value using the keypad ENTRY section keys.

9 Press the LEVEL key in the ENTRY section of the control panel.

10 Set the level to 0 dBm using the keypad ENTRY section keys.

11 On the CRT, verify OFF is highlighted in Modulation, if not press the ACTIVE key 5 to toggle it
OFF.

12 On the CRT, verify OFF is highlighted in Output, if not press the ACTIVE key 6 to toggle it OFF.

13 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

14 Connect the RF cable from the R3562 signal generator RF OUT port to the power sensor, refer to
Figure H-4.

15 On the R3562 CRT, set the Output to ON by pressing ACTIVE key 6.

. . . continued on next page
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Table H-2: Advantest R3267 Power Delta Calibration Procedure

Step Action

16 Record the Power Meter reading as result A________________________

17 On the R3562 CRT, set the Output to OFF by pressing ACTIVE key 6.

18 Connect the RF cable from R3562 signal generator RF OUT port to the R3267 spectrum analyzer
INPUT Port, refer to Figure H-5.

19 On the R3562 CRT, set the Output to ON by pressing ACTIVE key 6.

20 On the R3267, press the POWER key in the MEASUREMENT section of the control panel.

21 Press the LEVEL key in the ENTRY section of the control panel.

22 Set the REF LEVEL to 10 dBm using the keypad ENTRY section keys.

23 On the CRT, select dB/div by pressing ACTIVE key 1.

24 On the CRT, select 10 dB/div by pressing ACTIVE key 1.

25 Press the FREQ key in ENTRY section of the control panel.

26 Set the frequency to the desired value using the keypad ENTRY section keys.

27 On the CRT, select more 1/2 by pressing ACTIVE key 7.

28 Press the Preselector CRT menu key to highlight 3.66G.

29 Press the POWER key in the MEASUREMENT section of the control panel.

30 Press the SPAN key in the ENTRY section of the control panel.

31 On the CRT, select Zero Span by pressing ACTIVE key 2.

32 Press the COUPLE key in the ENTRY section of the control panel.

33 On the CRT, select RBW and highlight MNL by pressing ACTIVE key 3.

34 Set RBW to 30 kHz using keypad ENTRY section keys.

35 On the CRT, select VBW and highlight MNL by pressing ACTIVE key 2.

36 Set VBW to 1 MHz using keypad ENTRY section keys.

37 Press the MKR key in the DISPLAY CONTROL section of the control panel.

38 On the CRT, select Normal Marker by pressing ACTIVE key 1.

39 Record the Marker Level reading as result B________________________

40 Press Single in ENTRY section of control panel.

. . . continued on next page
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Table H-2: Advantest R3267 Power Delta Calibration Procedure

Step Action

41 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A - B

Example: Delta = -0.7 dBm - (-1.25 dBm) = 0.55 dB

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see step 4 in
Table H-6).

 

Figure H-3: Delta Calibration Setup - Advantest R3562 to HP437
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Agilent 8935 series E6380A Power Delta Calibration

The Agilent 8935 (formerly HP 8935) communications test set modified
with either option 200 or R2K and E4432B signal generator test
equipment combination can be used for ISC of IS-2000 CDMA 1X as
well as IS-95A/B operation modes. The power delta calibration is
performed on the Agilent 8935. After the offset value has been
calculated, add it to the TX cable loss value.

Follow the procedure in Table H-3 to perform the Agilent 8935 Power
Delta Calibration procedure.

Table H-3: Agilent 8935 Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter NO TAG.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable between the Agilent 8935 Duplex Out port and the HP437 power sensor
(see Figure H-6).

3 Set the Agilent 8935 signal source as follows:

- Measure mode to CDMA Gen
- Frequency to the CDMA Calibration target frequency

- CW RF Path to IQ

- Output Port to Dupl

- Data Source to Random

- Amplitude to 0 dBm

4 Measure and record the power value reading on the HP437 Power Meter.

5 Record the Power Meter reading as result A ________________________.

6 Turn off the Agilent 8935 signal source output, and disconnect the HP437.

NOTE
Leave the settings on the source Agilent 8935 for convenience in the following steps.

7 Connect the short RF cable between the Agilent 8935 Duplex Out port and the RF-IN/OUT  port (see
Figure H-7).

8 Ensure that the source Agilent 8935 settings are the same as in Step 3.

. . . continued on next page
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Table H-3: Agilent 8935 Power Delta Calibration Procedure

Step Action

9 Set the Agilent 8935 as follows:

- Measure mode to CDMA Anl
- Frequency to the CDMA calibration target frequency

- Input Attenuation to 0 dB

- Input port to RF-IN

- Gain to Auto

- Anl Dir to Fwd

10 Turn on the Agilent 8935 signal output.

11 Set the Chn Pwr Cal to Calibrate and select to calibrate.

12 Measure and record the channel power reading on the measuring Agilent 8935 as result
B ________________________.

13 Turn off the Agilent 8935 signal output and disconnect the equipment.

14 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see Step 4 in
Table H-6).

 

Figure H-6: Delta Calibration Setup - Agilent 8935 to HP437
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Figure H-7: Delta Calibration Setup - Agilent 8935 to Agilent 8935

Agilent E6380A

Short RF Cable

DUPLEX OUT RF IN/OUT

FW00806

H



Power Delta Calibration 68P09255A69-3

Aug 20021X SC�4812ET Lite BTS Optimization/ATP Software Release 2.16.1.x
PRELIMINARY

H-12

HP8921A Power Delta Calibration

Use the HP8921A communications test set to measure power during ISC
only for IS-95A and B operation of 800 MHz systems. After the offset
value has been calculated, add it to the TX cable loss value.

Follow the procedure in Table H-4 to perform the HP8921A Power Delta
Calibration procedure.

NOTE This procedure requires two HP8921A communication test sets.

Table H-4: HP8921A Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter NO TAG.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable between the HP8921A Duplex Out port and the HP437 power sensor (see
Figure H-8).

3 Set the HP8921A signal source as follows:

- Measure mode to CDMA Generator
- Frequency to the CDMA Calibration target frequency

- CW RF Path to IQ

- Output Port to Dupl

- Data Source to Random

- Amplitude to 0 dBm

4 Measure and record the power value reading on the HP437 Power Meter.

5 Record the Power Meter reading as result A ________________________.

6 Turn off the source HP8921A signal output, and disconnect the HP437.

NOTE
Leave the settings on the source HP8921A for convenience in the following steps.

7 Connect the short RF cable between the source HP8921A Duplex Out port and the measuring
HP8921A RF-IN  port (see Figure H-9).

8 Ensure that the source HP8921A settings are the same as in Step 3.

. . . continued on next page
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Table H-4: HP8921A Power Delta Calibration Procedure

Step Action

9 Set the measuring HP8921A as follows:

- Measure mode to CDMA Anl
- Frequency to the CDMA calibration target frequency

- Input Attenuation to 0 dB

- Input port to RF-IN

- Gain to Auto

- Analyzer Direction to Fwd

10 Turn on the source HP8921A signal output.

11 Measure and record the channel power reading on the measuring HP8921A as result
B ________________________.

12 Turn off the source HP8921A signal output and disconnect the equipment.

13 Compute the delta between HP437 and HP8921A using the following formula:

Delta = A - B
Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see Step 4 in
Table H-6).

 

Figure H-8: Delta Calibration Setup - HP8921A to HP437
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Figure H-9: Delta Calibration Setup - HP8921A to HP8921A

Measurement HP8921A Source HP8921A

Short RF Cable

DUPLEX
OUTRF

IN/OUT

FW00802

H



Power Delta Calibration68P09255A69-3

Aug 2002 1X SC�4812ET Lite BTS Optimization/ATP Software Release 2.16.1.x

PRELIMINARY
H-15

Advantest R3465 Power Delta Calibration
Use the Advantest R3465 spectrum analyzer to measure power during
ISC only for IS-95A and B operation. After the offset value has been
calculated, add it to the TX cable loss value.

Follow the procedure in Table H-5 to perform the Advantest 3465 Power
Delta Calibration procedure.

Table H-5: Advantest Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter NO TAG.

1 Press the SHIFT and the PRESET keys located below the CRT display.

2 Press the ADVANCE key in the Measurement area of the control panel.

3 Press the CDMA Sig CRT menu key.

4 Press the FREQ key in the Entry area of the control panel.

5 Set the frequency to the desired value using the keypad entry keys.

6 Press the LEVEL key in the Entry area of the control panel.

7 Set the LEVEL to 0 dBm using the keypad entry keys.

8 Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF, if not press the Output key to toggle it OFF.

10 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L CDMA signal generator RF OUT port to the power sensor,
refer to Figure H-10.

12 Press the Output CRT menu key to toggle the Output to ON.

13 Record the Power Meter reading as result A________________________.

14 Press the Output CRT menu key to toggle the Output to OFF.

15 Connect the RF cable from the R3561L signal generator RF OUT port to the R3465 INPUT Port,
refer to Figure H-11.

16 Press the Output CRT menu key to change the Output to ON.

17 Press the CW key in the Measurement area of the control panel.

18 Press the LEVEL key in the Entry area of the control panel.

19 Set the REF LEVEL to 10 dBm using the keypad entry keys.

20 Press the dB/div CRT menu key.

21 Press the 10 dB/div CRT menu key.

. . . continued on next page
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Table H-5: Advantest Power Delta Calibration Procedure

Step Action

22 Press the FREQ key in Entry area of the control panel.

23 Set the frequency to the desired value using the keypad entry keys.

24 Press the more 1/2 CRT menu key.

25 Press the Preselector CRT menu key to highlight 3.0G.

26 Press the FORMAT key in the Display Control area of the control panel.

27 Press the TRACE CRT menu key.

28 Press the AVG A CRT menu key.

29 Set AVG to 20 using keypad entry keys.

30 Press the return CRT menu key.

31 Press the SPAN key in the Entry area of the control panel.

32 Press the Zero Span CRT menu key.

33 Press the BW key in the Entry area of the control panel.

34 Press the RBW CRT menu key to highlight MNL. using keypad entry keys enter 30 kHz.

35 Set RBW to 30 kHz using keypad entry keys.

36 Press the VBW CRT menu key to highlight MNL.

37 Set VBW to 1 MHz using keypad entry keys.

38 Press the Marker ON key in the Display Control area of the control panel.

39 Record the Marker Level reading as result B________________________.

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see Step 4 in
Table H-6).
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Figure H-10: Delta Calibration Setup - R3561L to HP437
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In-Service  Calibration
CAUTION This feature does NOT have fault tolerance at this time. The

system has no safe-guards to prevent actions which will put the
BTS out of service. If possible, perform this procedure during a
maintenance window.

Follow the procedures in this section precisely, otherwise the
entire BTS will most likely go OUT OF SERVICE.

At the CBSC, only perform operations on expansion hardware
when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

Prerequisites
� Any applicable expansion hardware has been added in the CBSC

database, and a CDF which includes the additions has been generated.

� Any expansion devices have been inserted into the SCCP cage and are
in the OOS_MANUAL state at the CBSC MM.

� The site specific CDF (with any expansion hardware) and CAL files
have been loaded onto the LMF.

� The LMF has the same device binary code and dds files as the CBSC.

CAUTION Do not download code or data to any cards other than those
being worked on. Downloading code or data to other cards will
take the site OUT OF SERVICE.

The code file version numbers must match the current BSS
software release version numbers required for the equipped
devices (refer to Table 3-3). If the numbers do not match, the site
may go OUT OF SERVICE.

It is mandatory that the bts-#.cdf  and cbsc-#.cdf files
on the LMF computer for this BTS are copies of the
corresponding files created in the CBSC database (see
Table 3-2).

The CAL file loaded on the LMF computer for this BTS must
have come from the CBSC.

� Test equipment has been connected as shown in Figure H-12 or
Figure H-13.

� An RFDS (or as a minimum, a directional coupler), whose loss is
already known, must be in the applicable TX antenna path to perform
the in-service calibration.

� Test equipment has been calibrated after a 60-minute warm up.

� A short RF cable and two BNC-N adapters are available to perform
Cable Calibration.

� N-SMA cable adapters are available to connect to TRDC or DRDC
BTS CPLD connectors, and are included in cable loss measurements.
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� The Power Delta Calibration has been performed (see Table H-1,
Table H-2, Table H-3, Table H-4, or Table H-5).

Figure H-12: TX Calibration Test Setup - Agilent E4406A, Advantest R3267, and Agilent 8935 with Option
200 or R2K (IS-95A/B and 1X CDMA 2000)
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Figure H-13: TX Calibration Test Setup - HP 8921A/600 w/PCS Interface (1.9 GHz), 
HP 8921A/600 (800 MHz), and Advantest R3465 (IS-95A/B only)
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Follow the procedure in Table H-6 to perform the In-Service
Calibration.

Table H-6: In-Service Calibration

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

1 Set up the LMF for In-Service Calibration:

- Start the LMF by double-clicking the LMF icon on the Windows desktop.

- Click Tools > Options from the menu bar at the LMF application window.

- In the LMF Options window, check only the applicable communications system analyzer check
box on the Test Equipment tab.

- Ensure that the GPIB address is 18.

- Uncheck any other other equipment that is selected.

- Click the Apply button.

- Select the BTS Options tab in the LMF Options window.

- Check the In-Service Calibration check box.

- Click the Apply button.

- Click the Dismiss button to close the LMF Option window.

2 Log into the target BTS:

- Select the target BTS icon.

- Click the Login button at the login screen.

3 Measure the Cable Loss using the Cable Calibration function:

- Click Util > Cable Calibration... in the BTS menu bar at the main window.

- Set the desired channel(s) and select TX and RX CABLE CAL from the Cable Calibration
window drop-down list.

- Click the OK button to perform cable calibration.

- Follow the on-screen instructions to complete the cable loss measurement.

NOTE
- The measured value is input automatically to the cable loss file.

- To view the cable loss file, click Util > Examine > Cable Loss from the BTS menu bar.

4 Add the communications system analyzer power delta to the TX Cable Loss.

- In the BTS menu bar, click Util > Edit > Cable Loss... > TX.

- Add the value computed in Table H-4, Table H-5, or Table H-3 to the TX Cable Loss.

NOTE
Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

- Example: 5.65 dBm + 0.55 dBm = 6.20 dBm

- Example: 5.65 dBm + (-0.29 dBm) = 5.36 dBm

- Example: -5.65 dBm + 0.55 dBm = -5.10 dBm

- Example: -5.65 dBm + (-0.29 dBm) = -5.94 dBm

. . . continued on next page
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Table H-6: In-Service Calibration

Step Action

5 Input the Coupler Loss for the TX tests:

- In the BTS menu bar, click Util > Edit > Coupler Loss... from the menu bar at the main window.

- Select the TX Coupler Loss tab if not in the foreground.

- Enter the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

- Click the Save button.

- Click the Dismiss button to close the window.

- To view the coupler loss file, click Util > Examine > Coupler Loss in the BTS menu bar.

6 Input the Coupler Loss for the RX tests:

- In the BTS menu bar, click Util > Edit > Coupler Loss... from the menu bar at the main window.

- Select the RX Coupler Loss tab if not in the foreground.

- Enter the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

- Click the Save button.

- Click the Dismiss button to close the window.

- To view the couper loss file, click Util > Examine > Coupler Loss in the BTS menu bar.

7 If it was not previously done, have the CBSC operator put the redundant BBX OOS_MANUAL.

! CAUTION
Be sure to download OOS devices only. Loading in-service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX in steps 8, 9, and 10.

8 Download code and data to the target devices:

- In the LMF window menu bar, click Tools > Update NextLoad > CDMA to set the code version
that will be downloaded.

- Check the appropriate code version in the popup window and click the Save button to close.

- Select the target BBX(s) on the SCCP cage picture.

- In the BTS menu bar, click Device > Download > Code/Data to start downloading code and data.
. . . continued on next page
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Table H-6: In-Service Calibration

Step Action

9 ! CAUTION
Perform the All Cal/Audit procedure on OOS devices only.

Run the All Cal/Audit procedure:

- Select the target BBX(s) on the SCCP cage picture.

- In the BTS menu bar, click Tests > All Cal/Audit... from the menu bar at the main window.

- Select the target carrier and confirm the channel number in the pop up window.

- Leave the Verify BLO check box checked.

- Be sure the Test Pattern box shows Pilot.

- Click the OK button to start calibration.

- Follow the on-screen instructions, except, do not connect to the BTS antenna port. Connect to the
DRDC or TRDC BTS CPL port associated with the on-screen prompted antenna port.

10 Save the result, and download the BLO data to the target BBX(s):

- Click the Save Result button on the result screen.
-- The window closes automatically.

11 Logout from the BTS and close the LMF session:

- In the BTS menu bar, click Select > Logout to close the BTS connection.

- Close the LMF application program by selecting File > Exit from the window menu bar.

12 Disconnect all test cables from the BTS, and reconnect RFDS cables or termination loads, as
applicable, to the DRDC or TRDC BTS CPL ports used for the calibration.

13 Advise the CBSC to enable the target device(s).

14 Restore the new “bts-*.cal” file to the CBSC (refer to Table 5-2).
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Notes
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Numbers
10 MHz Rubidium Standard, optional test equipment,

1-11

10BaseT/10Base2 converter
LMF to BTS connection, 3-22
remove from BTS, 5-4

2:1 combiners, description, 1-20

2:1 TX combiner location, 1-30

2-way splitter, optional test equipment, 1-11

20-pair punchblock
description, 1-20
location, 1-20
punchdowns, 3-20

50-pair punchblock
description, 1-21
location, 1-21, 3-17
RGPS punchdowns

non-expansion frame, 3-19
primary expansion frame, 3-20
secondary expansion frame, 3-19

A
Abbreviated

RX acceptance test, all-inclusive, 4-8
TX acceptance test, all-inclusive, 4-8

Acceptance Test Procedure. See ATP

ACTIVE LED
GLI, 6-30
MCC, 6-32

Advantest R3465, setting GPIB address, F-8

Agilent E4406A, calibration, F-24

Alarm and Span Line Cable Pin/Signal Information,
3-17

ALARM LED, GLI, 6-30

Alarm Monitor window, 3-103

Alarm Reporting Display, 3-103

All Cal/Audit procedure, 3-86

All RX ATP Test Procedure, 4-11

All tests fail on a single antenna, Troubleshooting,
RFDS, 6-26

All TX ATP Test Procedure, 4-10

All TX/RX ATP Test Procedure, 4-9

Applying AC Power, 2-12

ATP
all inclusive TX acceptance test outline, 4-8
automated introduction, 4-1
code domain noise floor acceptance test procedure,

4-23
code domain power acceptance test procedure, 4-23
failure report generation, 4-27
FER test, frame error rate testing, 4-25
pilot time offset, 4-20
prerequisites, 4-2
spectral purity TX mask, 4-16
test matrix/detailed optimization, B-1
test set-up, 3-61

Advantest R3267/R3562
DRDCs, 3-64
TRDCs, 3-66

Advantest R3465, 3-61
Agilent 8935, DRDCs, 3-61
Agilent 8935/E4432B, DRDCs, 3-63, 3-65
Agilent E4406A/E4432B

DRDCs, 3-63
TRDCs, 3-65

CyberTest, 3-61
HP 8921A, 1.9 GHz, 3-62
HP 8921A, 800 MHz, 3-62

waveform quality (Rho), 4-18
waveform quality (RHO) acceptance test procedure,

4-18

ATP - Reduced, 4-1

Attenuator, required test equipment, 1-9

B
Basic Troubleshooting Overview, 6-1

Battery Charge Test (Connected Batteries), 2-15

Battery Discharge Test, 2-16

Bay Level Offset calibration
description, 3-78
purpose, 3-78
when to calibrate, 3-79

Bay Level offset calibration failure, 6-9

BBX
carrier spectral purity, 4-15
gain set point vs SIF output considerations, C-1
primary and redundant, TX tests to be performed,

4-13

BBX LED status combinations, 6-32

BBX2 Connector, 6-19

BLO. See Bay Level Offset calibration

Bringing modules into service, prepare to leave the
site, 5-4
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Broad Band Receiver. See BBX

BTS
download, 3-33
Ethernet LAN interconnect diagram, 3-30
LMF connection, 3-15, 3-22
log out of session, 5-4
RX sensitivity/frame error rate, 4-14
system software download, 3-3

BTS Frame Erasure Rate. See FER

BTS Log In Procedure, GUI, 3-24

BTS login
CLI environment, 3-26
General, 3-24
GUI environment, 3-24

BTS Logout
CLI environment, 3-28
GUI environment, 3-27

Create CAL File, 3-92

bts-nnn.cal File, 3-11

C
cable calibration, automatic, test set-up, 3-55, 3-56

Advantest R3267/R3562, 3-56
Advantest R3465, 3-55
Agilent 8935, 3-55
Agilent E4406A/E4432B, 3-56, 3-57
CyberTest, 3-55
HP 8921A, 3-55

CAL file. See calibration data file

Calibrating Cables, 3-71

Calibrating Test Cable Setup, PCS Interface
HP83236B, F-28

Calibrating Test Equipment, 3-71

Calibration, In-Service, H-20

calibration
calibration data file, 3-79
Gigatronics 8542B, F-27

Calibration Audit failure, 6-10

calibration data file, description of, 3-79

Cannot communicate to Communications Analyzer,
6-6

Cannot communicate to Power Meter, 6-5

Cannot Download DATA to any device card, 6-7

Cannot ENABLE device, 6-8

Cannot Log into cell-site, 6-2

Cannot perform carrier measurement, 6-15

Cannot perform Code Domain Noise Power
measurement, 6-15

Cannot perform Rho or pilot time offset
measurement, 6-14

Cannot perform Txmask measurement, 6-14

cbsc folder, 3-11

CDF
site configuration, 3-2
site equipage verification, 3-3
site type and equipage data information, 2-1

CDMA
allocation diagram for the North American, cellular

telephone frequency spectrum, D-4
optimization/ATP test matrix, B-1
subscriber mobile radiotelephone, optional test

equipment, 1-11

cdma Folder, 3-10

Cell Site
equipage verification, 2-1
types configuration, 3-2

Cell Site Data File. See CDF

Channel Service Unit, 3-15

CIO Connectors, 6-20

Clock Sync Module. See CSM

Code domain power/noise floor
acceptance test, 4-23
analyzer display, 4-24

code Folder, 3-12

Communication test set, rear panel, F-14, F-16

Communications test set. See Test equipment

communications test set, TX acceptance tests, 4-6

Connect BTS E1/T1 spans, 5-5

Connect BTS T1/E1 spans, 5-5

Connecting test equipment to the BTS, 3-50

Connector Functionality
Backplane, Troubleshooting, 6-19
Troubleshooting, Backplane, 6-19

Control, TX output verification, 4-6

Copy CBSC CDF Files to the LMF, 3-5

Copying CAL files from CDMA LMF to the CBSC,
5-1

Copying CAL files to the CBSC, 5-1

CSM
clock source, select, 3-36
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enable, 3-37
system description, 3-40

CSM clock source, select, 3-36

CSM frequency verification, 3-42

CSM LED Status Combinations, 6-28

D
data Folder, 3-13

DC Power Pre-test (BTS Frame), 2-7

DC Power Problems, SCCP Backplane
Troubleshooting, 6-23

DC/DC Converter LED Status Combinations, 6-27

Detailed, optimization/ATP test matrix, B-1

Devices, download. See Download

Digital Control Problems, 6-21
SCCP Backplane Troubleshooting, 6-21

Digital multimeter, required test equipment, 1-9

Directional coupler, required test equipment, 1-9

diversity receive path, definition, 3-78
companion frame, 3-78
stand-alone frame, 3-78

diversity RX path. See diversity receive path

Documents, required, 1-12

Download
See also Devices
BTS, 3-33
BTS system software, 3-3

Download BLO Procedure, 3-89

Download from the CBSC, prepare to leave the site,
5-3

download ROM and RAM code. See ROM code

Download/Enable MCCs, 3-39

Download/Enable MGLIs, 3-35

Duplexer, optional test equipment, 1-10

E
E1, isolate BTS from the E1 spans, 3-14

E4406A
calibration, F-24
setting GPIB address, F-2

E4432B, setting GPIB address, F-3

Enable CSMs. See CSM

End LMF session, 5-4

Equipment Overview, 1-16

Equipment warm-up, 3-54

establish MMI communication, 3-28

Ethernet LAN
interconnect diagram, 3-30
transceiver, 1-7

Ethernet LAN termination, 2-3

Every test fails, Troubleshooting, RFDS, 6-25

F
Failure report generation, 4-27

FER, acceptance test, 4-25

Files, intermediate file, 4-27

files, calibration data, 3-79

Filtronics, low IM Duplexer (Cm035-f2) or
equivalent, optional test equipment, 1-10

Fluke, model 8062A with Y8134 test lead kit, test
equipment, 1-9

Folder Structure Overview, 3-10

Foreword, xviii

forward link problem after passing reduced ATP, 6-14

Frame, equipage preliminary operations, 2-1

FREQ Monitor Connector, CSM, 6-29

Frequency counter, optional test equipment, 1-10

G
Gain set point, C-1

General Safety, xxiii

Generating an ATP Report, 4-27

General optimization checklist, test data sheets, A-4

Gigatronics 8541C, setting GPIB address, F-11

Gigatronics 8542 power meter, calibration, F-27

GLI Connector, 6-19

GLI Ethernet A and B Connections, 6-19

GLI LED Status Combinations, 6-30

GLI Pushbuttons and Connectors, 6-31

GLI2 Front Panel Operating Indicators, 6-31

GPIB, F-13, F-17, F-19
cables, 1-9
HP8935, F-6
interface adapter, switch settings, F-12
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set address, F-2
Advantest R3267, F-4
Advantest R3465, F-8
Advantest R3562, F-5
Agilent 8935, F-6
Agilent E4406A, F-2
Agilent E4432B, F-3
Gigatronics 8542B, F-11
HP 437B, F-10
HP 8921, F-7
HP83236A/B, F-7
Motorola CyberTest, F-9

GPIB box, switch settings, F-12

GPS, receiver operation, test data sheets, A-5

GPS Initialization/Verification
estimated position accuracy, 3-43
surveyed position accuracy, 3-43

GPS satellite system, 3-38

Group Line Interface. See GLI

H
Hardware Requirements, 1-6

High Stability 10 MHz Rubidium Standard, optional
test equipment, 1-11

High-impedance conductive wrist strap, required test
equipment, 1-10

HP 437
Pre-calibration, F-25
setting GPIB address, F-10

HP 83236A, F-17

HP 8921A PCS interface, Cables Connection for 10
MHz Signal and GPIB , F-14, F-16

HP 8921A/600 test set, 1-8

HP83236A/B, setting GPIB address, F-7

HP 8921A, setting GPIB address, F-7

HP8921A, F-17
Test equipment connections , F-13

HP8935, GPIB, F-6

HSO Initialization/Verification, 3-41

Huber & Suhner, required test equipment, 1-9

HyperTerminal, Creating named HyperTerminal
connection, 3-8

HyperTerminal , create named connection, 3-8

I
I and Q values, E-1

In-Service Calibration, H-20
preliminary Agilent test equipment set-up, H-2,

H-5
test set-up diagrams

DRDC, Advantest, 3-64
TRDC, Advantest, 3-66

Initial HP8921A setup, F-28

Initial Installation of Boards/Modules, preliminary
operations, 2-1

Initial power tests, test data sheets, A-3

Intermediate file, generate ATP file using, 4-27

IS-97 specification, E-1

L
LAN, optional test equipment, 1-10

LAN connectors, external, 2-3

LAN termination, 2-3

LED Status Combinations for all Modules except
GLI2 CSM BBX2 MCC24 MCC8E, 6-27

LFR, receiver operation, test data sheets, A-6

LMF, F-13, F-19
1X FER acceptance test, 4-6
1X upgrade preparation

checking for required HW Bin files, 3-7
home directory, 3-5

BTS connection, 3-22
logout procedure, 5-4
platform requirements, 1-6
remove from BTS, 5-4
terminal, 1-6
to BTS connection, 3-14, 3-15
TX acceptance tests, 4-6
view CDF information, 3-3

LMF BTS displays, 3-23

lmf Folder, 3-10

loads folder, 3-11

Local Maintenance Facility. See LMF

Log out
of BTS, 5-4
of LMF PC, 5-4

Logging Into a BTS, 3-24

Logging Out, 3-27

logical BTS numbering, 1-16
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LORAN-C  Initialization/Verification, 3-48

LPA errors, 6-8

LPA Module LED, 6-33

LPA Shelf LED Status Combinations, 6-33

M
Master Group Line Interface. See MGLI

MASTER LED, GLI, 6-30

MCC LED Status Combinations, 6-32

MMI common connections, 3-29

MMI Connector
CSM, 6-29
GLI, 6-31

MMI Connectors, MCC, 6-32

MMI equipment setup, 3-29

Module status indicators, 6-27

Motorola CyberTest, setting GPIB address, F-9

Multi Channel Card. See MCC

Multi-FER test Failure, 6-16

N
New installations, 1-4

No AMR control, 6-21

No BBX2 control in the shelf, 6-22

No DC input voltage to  Power Supply Module, 6-23

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX2 or Switch board, 6-24

No GLI2 Control through span line connection, 6-21

No GLI2 Control via LMF, 6-21

No or missing MCC24 channel elements, 6-22

No or missing span line traffic, 6-22

North American, cellular telephone system frequency
spectrum, CDMA allocation, D-4

O
Online Help, 3-29

optimization/ATP, test set-up
HP 8921A, 800 MHz, H-19
HP 8921A, 1.9 GHz, H-19

Optional test equipment, 1-10
10 MHz rubidium standard, 1-11

2-way splitter, 1-11
CDMA subscriber mobile or portable

radiotelephone, 1-11
duplexer, 1-10
frequency counter, 1-10
LAN tester, 1-10
oscilloscope, 1-11
RF circular, 1-11
RF test cable, 1-11
spectrum analyzer, 1-10

Oscilloscope, optional test equipment, 1-11

P
Patent Notification, xxvi

PCMCIA, Ethernet adapter
LMF to BTS connection, 3-22
remove from BTS, 5-4

Periodic optimization, 1-4

Pilot Time Offset. See PN

Pilot time offset, acceptance test, 4-20

Ping, 3-30

PN
offset programming information, E-1
offset usage, E-1

PN offset per sector, E-1

PN Offset Usage , E-1

power
applying, 2-20

AC, 2-20
DC, 2-21

removal, 2-18
AC power, 2-19
DC power, 2-18

Power Delta Calibration
Advantest, H-14
Agilent 8935, H-8
HP8921A, H-11

Power Input, 6-19

Power Meter, setting GPIB address, HP437B, F-10

Power meter
required test equipment, 1-9
setting GPIB address, Gigatronics 8542B, F-11
TX acceptance tests, 4-6

Power Supply Module Interface, 6-19

power-up, BTS. See power, applying

Pre-calibration, HP 437, F-25
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Pre-power tests, test data sheets, A-3

Preliminary operations
cell Site types, 2-1
test data sheets, A-2

Prepare to leave site
connect BTS E1/T1 spans, 5-5
connect BTS T1/E1 spans, 5-5
remove external test equipment, 5-3

Prepare to leave the site
bringing modules into service, 5-4
download code and data from CBSC, 5-3

Prerequisites, automated acceptance tests, 4-2

Procedures to Copy CAL Files From Diskette to the
CBSC, 5-1, 6-7

Procedures to Copy Files to a Diskette, 5-1

Pseudorandom Noise. See PN

PWR/ALM and ACTIVE LEDs, MCC, 6-32

PWR/ALM LED
BBX-1X, 6-32
BBX2, 6-32
CSM, 6-28
DC/DC Converter, 6-27
generic, 6-27
MCC, 6-32

R
R3267, setting GPIB address, F-4

R3562, setting GPIB address, F-5

RAM code, described, 3-33

receive path
calibration, 3-78

component verification, 3-79
definition, 3-78

Reduced ATP, 4-1

Remote GPS distribution. See RGPS distribution

Report generation, ATP report, 4-27

Required test equipment
communications system analyzer, 1-6, 1-8
digital multimeter, 1-9
directional coupler, 1-9
Ethernet LAN transceiver, 1-7
GPIB cables, 1-9
high-impedance conductive wrist strap, 1-10
power meter, 1-9
RF adapters, 1-10
RF attenuator, 1-9

RF load, 1-10
RS232 to GPIB interface, 1-7
timing reference cables, 1-9

Required test equipment and software, list, 1-6

RESET Pushbutton, GLI, 6-31

Revision History, xxv

RF
attenuator, 1-9
Circular - optional test equipment, 1-11
load for required test equipment, 1-10
required test equipment load, 1-10
test cable, 1-10

RF path, fault isolation, 6-11

RF path calibration. See Bay Level Offset calibration

RFDS - Fault Isolation, 6-25

RFDS calibration
description, 3-100
procedure, 3-101

RFDS Location, 1-29

RFDS parameters, 3-93
checking, 3-94
setting, 3-94

RFDS Test Subscriber Unit, 3-34

RFDS TSU Calibration Channel Frequencies, 3-100

RGPS distribution
description, 1-20
punchdowns

20-pair punchblock, 3-20
50-pair punchblock

non-expansion frame, 3-19
primary expansion frame, 3-20
secondary expansion frame, 3-19

Rho
TX waveform quality acceptance test, 4-18
waveform quality requirements, 4-18

ROM code
described, 3-33
downloading, G-1

procedure, G-2

RS232 to GPIB interface
modifications required for Automated Testing, 1-7
required test equipment, 1-7

RX
acceptance tests, FER, 4-25
antenna VSWR, test data sheets, A-11
sensitivity/frame error rate, 4-14

RX and TX paths fail, Troubleshooting, RFDS, 6-26



Index 68P09255A69-3

1X SC�4812ET Lite BTS Optimization/ATP Software Release 2.16.1.x

PRELIMINARY
Aug 2002Index-8

RX path. See receive path

S
SC 4812 BTS Optimization/ATP Test Matrix, B-2

SCCP Backplane Troubleshooting, Procedure, 6-20

SCLPA, convergence test data sheets, A-7

Selecting Test Equipment, 3-68

Set Antenna Map Data, 3-98

Set RFDS Configuration Data, 3-99

Setting Cable Loss Values, 3-76

Setting Control Port, 3-15

Setting TX Coupler Loss Value, 3-77

shut-down, BTS power. See power, removal

SIF, output considerations vs BBX gain set point, C-1

signal generator, 1X FER acceptance test, 4-6

Site, equipage verification, 3-3

Site checklist, verification data sheets, A-2

Site documents, 1-12

site equipage, CDF file, 3-2

Site expansion, 1-4

Span line
T1/E1 verification equipment, 1-11
troubleshooting, 6-34

Span line configuration, troubleshooting, 6-36

Span Line connector , 6-19

SPANS LED, 6-30

Spectral purity, TX mask - primary and redundant
BBX, 4-13

Spectral purity transmit mask, acceptance test, 4-16

Spectrum analyzer, optional test equipment, 1-10

STATUS LED, GLI, 6-30

Supported Test Sets, 3-51

SYNC Monitor Connector, CSM, 6-29

System Connectivity Test, F-17

T
T1, isolate BTS from the T1 spans, 3-14

Tektronics model 2445 test equipment, 1-11

Test data sheets
Alarm verification, A-11

general optimization checklist, A-4
GPS receiver operation, A-5
initial power tests, A-3
LFR receiver operation, A-6
pre-power tests, A-3
preliminary operations, A-2
RX antenna VSWR, A-11
SCLPA convergence, A-7
site checklist, A-2
TX antenna VSWR, A-9
TX BLO, A-8
verification of test equipment used, A-1

Test equipment
See also Optional test equipment; Required test

equipment
set up, TX output verification/control, 4-6
system analyzer, 1-8
TX acceptance tests, 4-6
verification data sheets, A-1

Test equipment connections , preliminary Agilent
E4406A/E4432B set-up, F-22

Test Equipment Setup Calibration for RX Bay Level
Offset, signal generator and spectrum analyzer,
3-74

Test Equipment Setup Calibration for TX Bay Level
Offset, F-32

Test Equipment Setup Chart, 3-52

Test equipment setup RF path  calibration, 3-82

Timing reference cables, required test equipment
Model SGLN1145A/4132A CSMs, 1-9
Model SGLN4132B CSMs, 1-9

transmit path
calibration, 3-78

component verification, 3-79
definition, 3-78

Transmit TX path audit, 3-90

Transmit TX path calibration, 3-83

Troubleshooting
DC Power Problems, 6-23
RF path fault isolation, 6-11
Set span configuration, 6-36
span problems, 6-34
TX and RX Signal Routing, 6-24
TX level accuracy fault isolation, 6-13

troubleshooting
communications system analyzer communication,

6-6
Ethernet LAN, 6-2
GLI IP address, 6-3
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LMF login failure, 6-2
power meter communication, 6-5
signal generator communication, 6-6

TSU NAM, programming
description, 3-96
parameter ranges, 3-97
parameters, 3-96
procedure, 3-102

TX
acceptance tests

code domain power/noise floor, 4-22
equipment setup, 4-6
pilot time offset, 4-20
spectral purity mask, 4-15

spectrum analyzer display, 4-17
waveform quality (rho), 4-18

all inclusive TX ATP test, 4-8
antenna VSWR, test data sheets, A-9, A-11
BLO test data sheets, A-8
level accuracy fault isolation, 6-13
output acceptance tests

code domain power noise, 4-13
pilot time offset, 4-13
waveform quality, 4-13

TX and RX Frequency vs Channel , D-2

TX and RX Signal Routing, SCCP Backplane
Troubleshooting, 6-24

TX Audit Test, 3-90

TX Bay Level Offset and TX ATP test equipment
setup calibration, signal generator and spectrum
analyzer, 3-73

TX calibration, 3-86
All Cal/Audit, 3-86
set-up, 3-58

Advantest R3267, 3-60, H-18
Advantest R3465, 3-59

Agilent 8935, 3-58
Agilent E4406A, 3-60, H-18
CyberTest, 3-58
HP 8921A, 3-59

TX calibration procedure, 3-88

TX combiners. See 2:1 combiners

tx fine adjust, E-1

TX path. See transmit path

TX path calibration, 3-86

TX/RX OUT Connections, 4-3

U
Updating CDMA LMF Files, 5-1

UTP, LMF to BTS connection, 3-22

V
verification during calibration, 3-79

Verify
test equipment used, test data sheets, A-1
TX output, 4-6

Verify GLI ROM code load, 3-34

version Folder, 3-12

W
Waveform quality (Rho), acceptance test procedure,

4-18

X
XCVR Backplane Troubleshooting, 6-19

Xircom Model PE3-10B2
LMF to BTS connection, 3-22
remove from BTS, 5-4
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Notes


